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Introduction

SECTION 1 ABOUT UM8000® 

UM8000 is a complete, self-contained voice messaging system consisting 
of a single plug-in blade that is installed directly into the SV8100/SV8300 
telephone system.

The voice blade includes hardware support for up to 16 voice ports and four 
fax ports. The voice blade also includes a compact flash disk (CF) that 
stores the voice messaging software and all voice recordings.  All software 
required to run the UM8000 system is pre-installed, including the Linux 
operating system and the UM8000 voice messaging system.

1.1 Supported Phone Systems

The UM8000 system is designed specifically for use with the 
SV8100/SV8300 telephone system manufactured by NEC.

The SV8100/SV8300 is enabled for the following UM8000 licenses 
at default:

0 Ports Voice Mail

5 Seats Unified Messaging

3 Languages

In addition, the following language prompt sets are loaded at 
default:

US English

French (Canadian)

Spanish (Latin America)

1.2 Starting the UM8000 for the First Time

Before starting the UM8000 for the first time, make the required 
settings and license agreements.  Refer to Chapter 3 Section 2 
Starting the UM8000 for the First Time on page 3-2 for information 
on third party software license agreements that must be accepted 
before the voice mail application can start.

If the license agreements are not accepted, the application cannot 
start.    
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SECTION 2 ABOUT THIS GUIDE

This Installation Guide provides complete instructions for installing and setting up a 
UM8000 voice messaging system.

2.1 Documentation Conventions

The following conventions are used throughout this guide.

Key names. Names of keys on the keyboard are shown in capital letters.

 Example:  OK 

When two keys must be pressed simultaneously they are joined by 
a + sign.

Example:  ALT+TAB

User input. Information required to be typed is shown in a distinctive font.

Example:  Type  names first 

Placeholder text. Variable text that will be replaced by specific text is 
shown in italics between angle brackets. 

Example:  vmctl <action> <service> <ENTER>
Notes, cautions, and warnings. Text for notes, cautions, and warnings 
appear as shown below:  

 

<ENTER>. Press the ENTER key on the keyboard when this character 
string appears after a command. In general, all command lines should be 
followed by pressing the ENTER key. 

Example:  vmctl vmail stop <ENTER>

NOTE

On the command line prompt, always press <ENTER> after typing a 
command. 

NOTE

A note provides additional information to supplement the main text. A note 
provides helpful information, but is not essential to understanding the 
current topic.

CAUTION

A caution advises you that failure to avoid or to take a specific action might 
lead to unwanted or undesirable results.

WARNING

A warning advises you that failure to avoid or to take a specific action 
might result in physical harm to the user, damage to the hardware or loss of 
data.
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2.2 Using the Command Line Interface

Communicating with the Linux operating system requires the use of tools and 
shells such as WinSCP and PuTTY. 

All procedures in this document are based on the WinSCP and PuTTY 
applications.  When using both applications, input devices include the keyboard 
or mouse.  Use the input device that you prefer.

     

SECTION 3 RELATED DOCUMENTATION

3.1 Supporting Documents

The documentation set for the UM8000 voice messaging system consists of the 
following:

Installation Guide – Provides instructions for installing and setting up a 
voice messaging system.

Input 
Device

Mouse
Click to choose Maintenance menu items and buttons; choose items in 
the Web administration console; and choose items or buttons in 
WinSCP. 

Keyboard

Command 
Prompt

Type a command with options then press the ENTER 
key. For example: 

mcedit /cps.ini <ENTER>
This command opens the cps.ini file in the mcedit tool. 

1, 2, 3,... 0 
To choose a menu item, type the numeric equivalent of 
a menu item. For example: 0 = Log out on the 
Maintenance menu. 

TAB Press the TAB key to move through menu items and 
command buttons in the Maintenance menu. 

UP (↑ ),
DOWN (↓), 
LEFT (←), 

and
RIGHT (→)     

Use the keyboard arrow keys to move between menu 
items, buttons, or options. 

Function 
Keys

Tools such as mcedit use function keys to execute 
specific actions. For example: F10, exits mcedit; F5 
saves the file, and so on. 

SPACEBAR

Press the SPACEBAR to toggle check marks off and 
on. For example, 

(*) Messages
Pressing the SPACEBAR clears the check box.

( ) Messages
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System Management Help – Provides online information and instructions 
for managing the voice messaging system.  This is available on-line from 
the Web Administration Console and as a stand alone help file on the 
Support CD.

The Installation Guide and User Guide are provided in PDF format on the 
support disc.  System Management Help is provided in a zip file on the support 
disc.

Adobe® Acrobat Reader is required to read and print the PDF files.  Adobe 
Reader versions for Windows® and Linux are provided on the support disc. The 
latest version of Adobe Reader can be downloaded from the Adobe Web site.

3.2 System Management Help

System Management Help provides immediate assistance while using the Web 
administration console. 

Click the HELP icon to see context-sensitive help for the current page. 
Refer to Chapter 3 Section 5 Web Administration Console Icons on page 
3-13. 

System management help can be installed locally on any computer for 
viewing. WinZip, or a similar file decompression program, is required to 
extract the help files.

3.2.1 Locally Installing Online Help Files

1. Insert the support disc into the disk drive. 

The autostart page appears.

2. Click Documentation, then follow the on-screen instructions. 

3. Click Install System Management Help locally.

4. Save the zip file to the local hard disk.

5. Use WinZip or another file decompression program to extract all
of the files to a local directory on the computer.

3.2.2 Third-Party Documentation

Compliance information for third-party electronic devices is provided in 
the third-party manufacturer documentation supplied with the UM8000 
system.

Do not use third-party documentation to install, upgrade or manage 
the voice messaging system. Use only the UM8000 documentation to 
install, upgrade, or manage the voice messaging system. 

NOTE

Pop-up windows must be enabled on the Internet browser to access 
some features of the Web administration console and system 
management help.  To enable pop-up windows for a specific site, refer to 
the Internet browser documentation.
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WinSCP and PuTTY 

SECTION 1 OVERVIEW

WinSCP (file transfer) and PuTTY (SSH utility) are open source programs 
that have been tested and approved for use with the voice messaging 
system. 

These programs can be downloaded from the Internet or they can be 
installed from the Support disc. 

SECTION 2 WINSCP

2.1 Installing WinSCP

The following procedure provides instructions for installing the 
WinSCP Client:

1. Insert the Support disc into the disk drive. 

The Autostart page appears. 

2. Using Windows Explorer, browse to the Utilities/
RemoteAccess/WinSCP/ directory.

3. Double-click winscp382setupintl2.exe to start the WinSCP 
installation. 

A security alert message appears. 

4. Click RUN.

The Select Setup Language page appears. 

5. Choose the appropriate language from the drop-down list, 
then click OK. 

The Welcome to WinSCP Setup Wizard appears. 

6. Click Next.

7. On the License Agreement page, click Next.

8. Accept the default installation path or type a new path, then 
click Next.
The Select components page appears. 

9. Accept the default components. If appropriate, choose a 
language for translation, then click Next.

10. Accept the default Start Menu folder name or type a new name, 
then click Next.
The Select Additional Tasks page appears. 
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11. Accept the default additional task settings, then click Next.
The Initial user settings page appears. 

12. Select one of the user interface styles, then click Next. All WinSCP 
procedures in this document assume that the Norton Commander 
interface is being used. 

  

The Ready to Install page appears. 

13. Verify that the settings are correct, then click Install. 
To review or change any of the settings, click Back. 

When the installation is complete, the Completing WinSCP3 Setup Wizard 
page appears. 

14. Clear the Start WinSCP now check box, then click Finish.

2.2 Using WinSCP

The following instructions assume that WinSCP is installed on a computer 
running the Windows XP operating system. 

2.2.1 Running WinSCP

The following procedure provides instructions to run WinSCP:

1. Click Start > Programs > WinSCP3 > WinSCP. 

The WinSCP Login window appears.

Interface Style Description

Norton Commander
(Preferred Option)

Displays source computer directories in the left pane 
and destination computer directories in the right pane.

Explorer-like Displays directories in the left pane and files in the 
right pane. 
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2. Click Session. 

3. Type the Host name (or IP address), User name, and Password. 

4. Click SAVE to save the login information for future sessions.

5. Click LOGIN.

A potential security breach message might appear, click YES.

The WinSCP console appears. 

2.2.2 Using PuTTY from WinSCP

This procedure assumes that PuTTY is installed. Refer to 
Section 3.1 Installing PuTTY.

1. In WinSCP, click Commands > Open in PuTTY.

When the first connection is made, a PuTTY security alert appears. 
The alert does not appear in subsequent connections. Click Yes.

The PuTTY window appears with a password prompt.

2. Type the admin password: voicemail.
When a connection is established, the Maintenance menu appears. 
To use PuTTY without WinSCP, refer to Section 3 PuTTY.

SECTION 3 PUTTY

3.1 Installing PuTTY

After configuring the TCP/IP settings, run a PuTTY SSH client on the remote 
computer to connect to the voice board, and complete the software 
configuration.

The following procedures assume that PuTTY will be installed on a computer 
running the Windows XP operating system and it is being installed from the 
Support disc.

Use this procedure to install PuTTY on the voice messaging system, a client 
computer, or on a remote computer. 

NOTE

The IP address for the voice mail is assigned in chassis 
programming 10-55-xx.  At default this address is 
172.16.1.xxx, where .xxx is the slot where the CD-VM00 is 
installed.  Slot 1 is .100, slot 2 is .101, slot 5 is .104, and so 
on.  The user name: admin, and password: voicemail.

NOTE

Only PuTTY and WinSCP SSH clients are supported. 



Issue No. 1.0 UM8000

2 - 4 WinSCP and PuTTY

To install the PuTTY, perform the following procedure: 

1. Insert the Support disc into the disk drive. 

The autostart page appears. 

2. Using Windows Explorer, go to the Utilities/RemoteAccess/Putty/ directory. 

3. Double-click putty-0.59-installer.exe to start the PuTTY installation. 

An Open File security alert message appears. 

4. Click RUN.

The Welcome to the PuTTY Setup Wizard appears. 

5. Click Next. 
The Select Destination Location page appears. 

6. Accept the default installation path or type a new path, then click Next.
The Select Start menu folder page appears. 

7. Accept the default components, if appropriate, choose a language for 
translation, then click Next.

8. Accept the default Start Menu folder name or type a new name, then click 
Next.

9. The Select Additional Tasks page appears. 

10. Select the appropriate tasks to complete, then click Next.
The Ready to Install page appears. 

11. Verify that the settings are correct, then click Install. 
To review or change any of the settings, click Back. 

12. Clear the View README.txt check box, then click Finish.

3.2 Configuring PuTTY

To configure PuTTY, perform the following procedure:

1. On the Windows taskbar, click Start > Programs > PuTTY > PuTTY. 

The PuTTY Configuration page appears.

2. Use a network crossover cable to connect the voice board to a computer. 

3. Type in the Host Name (or IP address) field. 

The IP address for the voice mail is assigned in chassis programming 10-
55-xx.  At default this address is 172.16.1.xxx, where .xxx will vary 
depending upon which slot the CD-VM00 was installed.  Starting with slot 
1 this will be .100, slot 2 will be .101, slot 5 will be .104 and so on.

4. Click Open. 

When the first connection is made, a warning message appears. The 
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warning message does not appear for subsequent connections. Click Yes. 

After the client connects to the voice board, the login prompt appears: 
Logging On and Logging Off Using PuTTY.  Refer to Section 3.3 Logging 
On and Logging Off Using PuTTY on page 11-4. 

3.3 Using PuTTY

The following procedures assume that PuTTy is installed on a computer 
running the Windows XP operating system and you are using a keyboard and 
mouse as input devices. 

Use PuTTY for remote SSH terminal access.

To run PuTTY, perform the following procedure:

1. Click Start > Programs > PuTTY > PuTTY. 

The PuTTY Configuration window appears. 

2. Type the Host Name or IP address, then press  <ENTER>. 

The shell appears with a login prompt. 

3. Type a user name, admin <ENTER>. 

4. Type the password at the password prompt, voicemail <ENTER>. 

The Maintenance menu appears.

NOTE

The IP address for the voice mail is assigned in chassis programming 
10-55-xx.  At default this address is 172.16.1.xxx, where .xxx is the slot 
where the CD-VM00 is installed.  (Slot 1 is .100, slot 2 is .101, slot 5 is 
.104, and so on.)
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The Web Administration Console

SECTION 1 OVERVIEW

The voice messaging system Web Administration Console is a web-based 
application that enables access to the voice messaging system. 

The Web Administration Console is accessed using the voice messaging 
system or a networked computer. 

1.1 Supported Internet Browsers

Because the Web Administration Console is a web-based 
application, an internet browser is required to access the Web 
Administration Console. 

The following Internet browsers are supported:

Windows Internet Explorer 6.x or above

Fire Fox 2.x or above

Mozilla

1.2 Configuring Internet Explorer

The following procedure configures Internet Explorer to work with 
the Web Administration Console. Refer to the browser 
documentation to configure other Internet browsers.

To configure Internet Explorer:

1. Start Internet Explorer, then click Tools > Internet Options.

2. Click the Security tab.

3. Click the Local intranet icon, then click Sites.  The Local 
intranet dialog box appears.

4. Click Advanced

The Local intranet Add Web site dialog box appears. 

5. In the Add this Web site to the zone text box, type: 

http://<server name> 

where <server name> is the IP Address of the voice messaging
server. 

6. Click Add.

7. Verify that http://<server name> appears in the Web sites list 
box.
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8. Click Close. 

9. Click OK to close the Local intranet window.

10. On the Internet Options dialog box, click Custom Level.

The Security Settings dialog box appears. 

11. In the Security Settings dialog box, verify the settings for the following 
ActiveX controls and plug-ins:

12. Click OK.

A warning alert message appears.

13. On the warning alert message, click Yes to confirm the security changes.

14. Click OK to close the Internet Options dialog box.

SECTION 2 STARTING THE UM8000 FOR THE FIRST TIME

Before starting the UM8000 for the first time, make the required settings and license 
agreements.  To access settings options and license agreements, connect to the Web 
Administration Console (WAC) using an internet browser.  

If the license agreements are not accepted, the application cannot start.   

The following procedure provides instructions for starting the UM8000 for the first time:

1. First determine the IP address of the voice mail by checking program 10-55-01 
for the slot where the blade is installed.

2. Start your internet browser and enter the IP address followed by 
/admin in the URL window.  

Example:  172.16.0.100/admin.

3. Press <ENTER>.

ActiveX controls and plug-ins Setting
Automatic prompting for ActiveX controls Enable
Binary and script behaviors Enable
Download signed ActiveX control Prompt
Download unsigned ActiveX controls Enable
Initialize and script ActiveX controls not marked as safe Enable
Run ActiveX controls and plug-ins Enable
Script ActiveX controls marked safe for scripting Enable

NOTE

If the voice mail database is defaulted, this procedure must be repeated.
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4. Accept the certificate and log into the WAC with the user name: $nec.  No 
password is required. 

Figure 3-1  UM8000 Login
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5. You are prompted to accept the third party software license agreement.

Figure 3-2  Third Party Software License Agreement



UM8000 Issue No. 1.0

Installation Manual 3 - 5

6. Choose the phone system where the voice mail is to be installed. 

Figure 3-3  UM8000 Switch Information
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Figure 3-4  UM8000 Integration Options
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7. Set the extension numbers that are assigned to the voice mail in program 
11-02-01.  Select  Edit All.  Enter the extension number for each voice mail port, 
then click Save. 

Figure 3-5  Entering Switch Extensions for Voice Mail Ports, Screen 1
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Figure 3-6  Entering Switch Extensions for Voice Mail Ports, Screen 2
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8. To register the equipment at this time, enter the registration information on the 
Product Registration Form screen.  The voice mail must have access to the 
internet for the registration to be successful.  You can also choose not to register 
at this time or to be reminded in seven days. 

Figure 3-7  Product Registration Form
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9. You are now logged into the WAC, but the application is not yet started.

Figure 3-8  System Information 
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10. Start the application by going to Server Control and clicking on the Start icon.

SECTION 3 LOGGING ON TO THE WEB ADMINISTRATION CONSOLE

Use the following procedure to start the Web Administration Console.

3.1 Logging In

1. Make sure the voice messaging system is running. 

2. Start the Internet browser and click File > Open.

The Open dialog box appears.

3. Type the Web Administration Console URL: 

http://<IP address>/admin
Where <IP address> is the voice messaging system server IP address.
The IP address for the voice mail is assigned in chassis programming 10-
55-xx.  At default this address is 172.16.1.xxx, where .xxx varies
depending on the slot in which the CD-VM00 is installed.  Starting with slot
1, this is .100, slot 2 is .101, slot 5 is .104, and so on.  

4. Click OK. 

Figure 3-9  Server Control Start Icon
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5. Type a system manager ID in the User field.

6. In the Password field, type the appropriate security code. 

7. If appropriate, select a different language. 

8. Click Login. 

The Web Administration Console appears.

3.2 Logging Off

1. Click Logoff at the top right-hand corner of any page.

SECTION 4 WEB ADMINISTRATION CONSOLE PAGES

Many of the Web Administration Console pages are divided into four sections.    

System Manager ID
New system $nec
Existing system Personal ID

Password
New system Leave password field blank
Existing system Password

1 2

3 4
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SECTION 5 WEB ADMINISTRATION CONSOLE ICONS

The task bar in the Web Administration Console contains one or more command icons 
at the top. These perform the following functions: 

Key Screen 
Location Description

1 Title bar

Contains the application name, the link to 
the Web Administration Console main 
menu, page/record information, and the 
system date and time. 

2 Task bar Contains the command icons, user logon 
information, and the logoff link.

3 Navigation 
pane

Contains links to other Web Administration 
Console pages.

4 Page Contains fields where data is entered and 
displayed.

Icon Description

Save changes.

Search for items of the type you are currently viewing.

Add items of the type you are currently viewing.

Delete items of the type you are currently viewing.

View the previous record.

View the next record.

Open System Management Help.
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SECTION 6 WEB ADMINISTRATION CONSOLE MAIN MENU

When the Web Administration Console starts the Main menu appears in the navigation 
pane. 

The navigation pane is located on the left side of each system page. The navigation 
pane that has links to the Web Administration Console web pages. Each link in the 
navigation pane contains one or more pages with related fields. To move to a page, 
click the link in the navigation pane. Some links contain multiple pages of related 
settings.

Subscribers. Use these pages to configure settings for individual subscribers 
and guests, and to create subscriber templates. Settings include schedules, 
passwords, account permissions, phone greetings, call processing, and transfer 
options.

Call Management. Use these pages to specify how UM8000 answers, routes, 
transfers, and records calls. Settings include call handling settings for the operator, 
opening greeting, any routing applications and menus, languages, and voice detect 
applications.

Groups. Use these pages to configure or create message groups.

Hotel Guests. Use these pages to configure settings for hotel guests. Settings 
include greetings, passwords, wake-up calls, call handling, and message waiting 
notification.

Reports. Use these pages to generate reports of subscriber-based or system-
based information, including message activity, message groups, phone sign-ins, 
disk storage, administration access, port usage, software information, and fax 
activity. 

Network. Use these pages to add and view locations within a voice messaging 
network.

System. Use these pages to set general information about the voice messaging 
system, such as site contact information, message storage and playback settings, 
system prompts, schedules, port settings, and phone system integration.

Port Status. Use this page to view the current activity and status of each port or 
incoming phone line. The port status information appears in a new window. 

Server Control. Use this page to start or stop the voice messaging software.

NOTE

The hotel guest pages are only available if the optional hospitality package is 
installed.

NOTE

The network pages are only available if the optional networking package is 
installed.
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System Components

SECTION 1 OVERVIEW

Read this chapter before starting the installation. This chapter provides 
preliminary information and guidelines that will help you during the 
installation. 

1.1 System Components

The components listed are included as part of the voice messaging 
system. Gather the information, tools, and hardware listed in this 
chapter before starting the system configuration. 

1.2 NEC-supplied Components

Verify that all the following components were shipped with the 
system. If any of these items are missing, contact your sales 
representative.

UM8000 Blade

UM8000 CF Drive

UM8000 Support Disc

Contains the UM8000 documentation in PDF format, System 
management help, Adobe Acrobat Reader®, WinSCP, PuTTY, 
language archives (system HVM), and Sun Java Runtime 
Environment™ (JRE).

UM8000 Visual Messaging Application Resource Disc

Contains the Visual Messaging applications enabling 
subscribers to use desktop workstations to access and 
manage voice messages in various ways. 

Everything needed to support Visual Messaging is pre-
installed on the voice messaging system. The Visual 
Messaging applications must also be installed on each client 
workstation.

For information about installing and configuring Visual 
Messaging, see the Visual Messaging Installation Guide.

Remote maintenance software and voice messaging system 
applications must be installed on a remote computer to 
support remote maintenance.

An internal or external USB DVD-ROM drive is required to 
read the DVD text-to-speech and language packs.
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1.3 User-supplied Components

In addition to the above components, you also need some or all the following 
user-supplied items.

Network cable

■ A standard CAT-5 network cable for LAN connections

■ A crossover network cable for a direction connection to another 
computer

Monitor (optional)

Connecting a monitor directly to the CD-VM00, enables you to observe 
the boot process.

USB keyboard, compatible with Linux (optional)

Connecting a keyboard and monitor directly to the UM8000 blade enables 
you to interact with the switch, log on and off, and configure the UM8000 
blade.

Antistatic wrist strap

Use an antistatic wrist strap when handling the UM8000 blade.

Network connection

SECTION 2 SITE REQUIREMENTS

Ensure that the phone system is located in a site that meets the following 
requirements:

The site is cool, dry and free of dust.

The phone system remains immobile while in operation.

The phone system cooling vents are not obstructed in any way.

2.1 Site Recommendations

The following recommendations help protect the phone system and UM8000 
from potential damage and unauthorized access:

Use a surge suppressor or an uninterruptible power supply (UPS) to 
protect the phone system and UM8000 against sudden variations in 
electrical power.

Do not move the phone system while the power is on.

WARNING

Failure to use an antistatic wrist strap can cause damage to the 
CD-VM00, the phone system, or both.
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Do not remove the UM8000 blade from the phone system while the voice 
messaging system is running. Refer to Chapter 5 Starting and Stopping 
the Voice Messaging Software and System.

Control access to the room where the phone system and UM8000 are 
installed. Do not install these systems in an area where unauthorized 
persons might have access to them.

Failure to follow these recommendations can result in damage or unauthorized 
access to the system and loss of data.

2.2 Setting Up the System Overview

The following is a summary of the major steps required to install a new UM8000 
system.  Detailed procedures are provided in the following chapters. 

1. Verify that the installation and site requirements are met.  Refer to Section 
2.1 Site Recommendations on page 4-2 in this chapter.

2. Install the voice blade.

This step is only required if you are replacing an existing voice blade.  Refer 
to Chapter 6 Hardware.

3. Establish a connection to the phone system. 

4. Set up the phone system.

Refer to  Chapter 10 Section 3.1 Configuring TCP/IP on page 11-2 and 
Chapter 4 Section 1.2 Configuring Internet Explorer on page 3-1.

5. Set up the UM8000 software.

Refer to Chapter 8 Section 5 Setting Up the UM8000 Software on page 9-12

6. Set up remote maintenance.

Refer to Chapter 11 Remote Maintenance.

7. Set up optional features:

For information on E-mail integration, refer to Chapter 10 E-mail Integration.

For information about installing and configuring Visual Messaging, refer to the 
Visual Messaging Installation Guide.

8. Optionally: 

Upgrade version

Migrate OS/2 system

Migrate DOS system

9. Backup the voice messaging data.

For information, refer to Chapter 12 Backing up and Restoring UM8000.
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5
Starting and Stopping the Voice Messaging 
Software and System

SECTION  1 OVERVIEW

Stop and start the voice messaging software using the Web Administration 
Console.

Some procedures require stopping the voice messaging software. Other 
procedures require stopping and restarting the voice messaging software 
to apply configuration changes. Whatever the reason, use the following 
procedure to stop or start the voice messaging software. 

SECTION 2 STOPPING/STARTING USING THE WEB ADMINISTRATION 
CONSOLE

To start or stop the voice messaging software using the Web Administration 
Console, perform the following procedure:

1. Log on to the Web Administration Console.

2. Click Server Control.

3. Click Stop to stop the voice messaging software, or Start to start the 
voice messaging software. 

NOTE

The voice messaging software might take a few minutes to shut down 
completely.
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Hardware

SECTION  1 CD-VM00 BLADE (VOICE MAIL AND SERVER)

1.1 Description

The CD-VM00 blade is a complete, self-contained unit that plugs 
directly into the UM8000 telephone system.  This blade is a PC 
platform that contains data storage for voice recording and 
application software supporting a maximum of 16 ports.  Only one 
CD-VM00 can be installed per system. 

The board includes a compact flash disk that provides storage for 
the voice messaging software, messages, and recordings. Software 
required to run the voice messaging system is pre-installed on the 
disk.  Figure 6-1 CD-VM00 Blade–Top View on page 6-2 shows the 
top view of the CD-VM00 voice board.

1.2 Functions

A digital signal processor/voice processing section handles the 
following functions:

DTMF detection

DTMF generation

General tone detection

FAX CNG tone detection

PCM compression for audio recording/playback

Automatic Gain Control (AGC)

Two USB 1.0 ports for USB keyboard support, database 
backup and software upgrades

One 15-pin VGA connector for VHA monitor support
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SECTION 2 INSTALLATION

Figure 6-1  CD-VM00 Blade–Top View

Ethernet LEDs Flash Card

Memory

Battery
Active LED

Load Button

RJ-11/Serial

VGA Monitor

USB

RJ-45/10/100

Back Plane

APP LED

Busy LED

CF Active Drive LED

CAUTION

When installing the blades, observe the following precautions to avoid 
static electricity damage to hardware or exposure to hazardous voltages.

The CD-VM00 unit makes extensive use of CMOS technology and is 
very susceptible to static.  Handle with extreme care to avoid static 
discharge.

Handle the drive and DSP carefully to prevent damage. Do not drop the 
drive or apply pressure to it.
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Perform the following procedure to install the CD-VM00.

1. Wear a grounding strap while handling the CD-VM00 and  DSP. Lay the compo-
nents on a flat work surface.

2. Mount the CR-2032 battery with the “+” side up in the “BATT” slot on the 
CD-VM00. Refer to Figure 6-2 Install the CR-2032 Battery on page 6-3.   

3. To install the SO-DIMM memory on the CD-VM00 blade, insert the end with the 
brass connectors into the CN14 1 slot.  Then, push the other end down until the 
locks on both sides lock into place.  Refer to Figure 6-3 Install the SO-DIMM 
Memory on page 6-3.   

Figure 6-2  Install the CR-2032 Battery

Figure 6-3  Install the SO-DIMM Memory
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4. Install the Compact Flash drive into slot CN7. Ensure the drive is 
fully seated in the slot.  Refer to Figure 6-4 Install the Compact 
Flash Drive on page 6-4.  

SECTION 3 LOAD PUSH-BUTTON SWITCH

The Load push-button switch on the CD-VM00 Blade provides the following functions:  

3.1 Initialize Factory Defaults

To initialize factory defaults, perform the following steps:

1. Turn off power for the Chassis where the CD-VM00 is installed.

2. Press and hold the Load button on CD-VM00.

3. While holding the Load button, turn on Chassis power.

4. Continue to hold the Load button for 20 seconds.

5. Release the Load button.

3.2 Reset CD-VM00 (APSU)

To reset the CD-VM00, perform the following operation:

1. While the voice mail is running, hold the Load button for more  than three 
seconds.

Figure 6-4  Install the Compact Flash Drive

NOTE

Do not press the reset button while the voice messaging system is running. This can 
corrupt the database.
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SECTION 4 LED INDICATIONS

The following table describes the LED indicators.

SECTION 5 CONNECTORS

The following sections go into detail on each of the user interfaces.

5.1 RS-232 Interface

An RS-232 interface is provided as a debug port to the CPU. The AMD Geode 
companion chip (CS5536) provides a serial port interface. The CS5536 is 
connected to an Intersil-Harris HIN202ECBN (or equivalent) RS-232 
transceiver providing a DTE interface (COM1) with the following signals: TD, 
RD, DSR, DTR and GND. 

Table 6-1  LED Indicators

LED ID Color(s) Description Indication

Active Green

Off Power off.

On Reset.

Slow Flash Board is running but not in sync 
with the chassis yet.

Fast Flash Board is in sync with chassis and 
operating normally.

Busy Red

Off Power off or idle.

On Reset.

Flash

Indicates how many ports on the 
VM card are currently in use. 
Faster flash rates indicate heavier 
use.

Application Red/Green

Off Power off.

Solid Red/Green
(Yellow) Reset.

Flashing Green OS is running, application not 
started.

Solid Green Application running.

Solid Red Application problem.

CompactFlash 
Card Activity Red On

Indicates read/write activity on the 
CampactFlash card - controlled by 
the IDE controller.
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The CD-VM00 uses the same 6-pin modular jack as the DSX system.  A 
standard telephone line cord is used as the RS-232 cable.  A DB9 to 6-pin 
modular adapter is used on the device end of the cable.  Refer to Figure 6-5 
CD-VM00 DB9 to 6-Pin Modular RS-232 Adapter on page 6-6.  

The pin connections of RS-232 signal pairs are symmetrical around the center 
line of the 6-pin modular connector. This signal layout permits the construction 
of a null serial cable by simply reversing one of the modular connectors on the 
serial cable line cord.

The cable used for a PC type DTE connection is a standard line cord shown in 
Figure 6-6 CD-VM00 RS-232 Serial Cable (DTE) on page 6-6. RS-232 Serial 
Cable (DTE).   

Figure 6-5  CD-VM00 DB9 to 6-Pin Modular RS-232 Adapter

Figure 6-6  CD-VM00 RS-232 Serial Cable (DTE)



UM8000 Issue No. 1.0

Installation Manual 6 - 7

The connection for a DCE device uses the swapped line cord shown in Figure 
6-7 CD-VM00 RS-232 Serial Cable (DCE) on page 6-7. 

5.2 USB Interface

The CD-VM00 provides two USB interfaces that are in full compliance with the 
Universal Serial Bus Specification, Revision 2.0. The connections to the USB 
interface are through a dual Type-A plug connector.  Some possible USB 
devices are the following:

USB Keyboard 

USB Memory Device

Per the USB spec, each USB device must start up in a low power mode 
drawing one unit (100mA) of current. The device may then request more power, 
up to 5 unit loads. For the APSU application, current draw of greater than one 
unit load per device shall not be allowed. To limit the current draw on the 5V 
received from the backplane, a dual power switch, TI TPS2046A or equivalent, 
shall be utilized to allow power enable control to the USB ports and to protect 
against short circuit events. If it becomes necessary to connect a high power 
USB device to the APSU, an externally powered USB hub could be inserted 
between the APSU and the high power device.

5.3 VGA Display Interface

The APSU card provides a VGA display interface through a standard DB-15 
connector. The AMD LX-800 Processor interfaces directly to the VGA 
connector. The VESA standard pin-out shall be used. Per the VESA standard, 
5V is required to be supplied to the connector in order to support the DDC I2C 
communication channel to the monitor only when the monitor is in sleep mode.  
When the monitor is not in sleep mode, 5V is provided by the monitor power 
source.

On the APSU, 5V shall be provided to the VGA connector in a manner where it 
can be removed from the connector via component depopulation to reduce 
current draw on the 5V power supply should this feature not be needed.

Figure 6-7  CD-VM00 RS-232 Serial Cable (DCE)
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5.4 10/100 BASE-TX Ethernet Interface

The APSU card provides a 10/100 Ethernet interface through an RJ-45 
connector. Some possible uses for the Ethernet port are the following:

Unified Messaging (Email)

Software Update

Application Configuration

Text to Speech and Speech Recognition using an external server

Network Attached Storage (NAS)

The Via VT6107 Ethernet controller shall be used. It interfaces to the CPU over 
a 33 MHz PCI bus and connects directly to an Ethernet RJ-45 connector with 
built-in magnetic and LEDs. The RJ-45 connector pin-out is shown in Table 6-2 
Ethernet Connector Pin-Out on page 6-8.  

 

Table 6-2  Ethernet Connector Pin-Out

View Pin No. Signal Note

1 Tx+

PIN1 ---- PIN8 2 Tx- 10BASE-T/100BASE-TX port 
(RJ-45 connector)

3 Rx+

4 NC

5 NC

6 Rx-

7 NC

8 NC
1           8
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Setting Up Integration (SV8100)

SECTION 1 OVERVIEW

This chapter describes setup and programming for integrating the SV8100 
telephone system and the voice messaging system.

SECTION 2 SETTING UP INTEGRATION

Extensions must be installed and set up for each voice messaging 
port. 

Hunt groups, trunk routing, and call overflow must be programmed so 
that the proper calls are routed to the voice messaging system. 

Test the voice messaging system extensions for the integration. 
Confirm that the voice messaging extensions are configured properly 
to integrate with the voice server.

Learn the telephone system tones, if necessary. Use the Global Tone 
Detect utility to configure the voice server to recognize the system 
tones. 

SECTION 3 CONFIGURING INTEGRATION

Additional voice messaging system features are set up on the 
Administration Console screens:

Easy Message Access

Identified Subscriber Messaging

Trunk Mapping for Transaction Boxes
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SECTION 4 PROGRAMMING

4.1 Basic Configuration 

Program/
Item No. Description Required

10-09-01 DTMF and Dial Tone Circuit Setup 

11-07-01
Department Group Pilot Numbers choose Department 
Group and define Pilot Number 

X

11-12-42

Service Code Setup (for Service Access), Flash on 
Trunk Lines This code is used for Centrex Transfer 
using Digital voice mail ports. If this code starts with # 
then 45-01-05 must be set to 0 (Off). 

14-01-22 Basic Trunk Data Setup – Caller ID to Voice Mail

14-02-10 Analog Trunk Data Setup – Caller ID

15-02-08 Message Waiting LED Color 

15-02-26
Multiline Telephone Basic Data Setup, MSG Key 
Operation Mode 

15-03-01
Single Line Telephone Basic Data Setup - SLT 
Signaling Type set all Voice Mail ports to 0 (DP)

15-03-03
Single Line Telephone Basic Data Setup - Terminal 
Type set all Voice Mail ports to Special 

X

15-03-09
Single Line Telephone Basic Data Setup -Caller ID 
Function for External Module 

15-07-01 Programmable Function Keys 

16-01-01 Department Name 

16-01-04 Hunting Mode 

16-01-10 Enhanced Hunt Type 

16-02-01

Department Group Assignment for Extensions put all 
Voice Mail ports in Group Number used in 11-07-01 
and assign priorities 

When setting up hunt group priorities the VM ports 
must be assigned as port 1 = priority 1, port 2 = 
priority 2 and so on.  Failure to do this will cause the 
VM to answer but no audio will be heard.

X

20-02-09
System Options for Multiline Telephones - Disconnect 
Supervision 

20-09-07
Call Queuing, turn off or on an extension ability to 
have calls queued if a call rings the extension when it 
is busy.
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4.2 Class of Service

It is recommended the voice mail extensions be put in Station Class of 
Service No. 1.

20-13-06
Automatic Off-Hook Signaling (Automatic Override),  
allows a busy extension ability to manually (0) or 
automatically (1) receive off-hook signals.

45-01-01
Voice Mail Integration Options, Voice Mail Department 
Group Number assign Group Number used in 
11-07-01 

X

45-01-02
Voice Mail Integration Options, Voice Mail Master 
Name 

45-01-05

Voice Mail Integration Options, Message Wait When 
using Centrex Transfer from a voice mail port, then 
the following items must be considered: 
1) If the Feature Access Code starts with “#”, then 

set PRG 45-01-05 to 0 (Off). 
2) When assigning the dial string in voice mail, one 

or more “Pauses” may be needed depending on 
what Telco needs. 

45-01-06
Voice Mail Integration Options, Record Alert Tone 
Interval Time 

45-02-01 Send DTMF tone or 6KD message, should be set 1. X

45-02-03 Send 51A Message, should be set 1. X

Program/
Item No. Description Required
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4.3 Assign Trunks as Automated Attendant Trunks

Program/
Item No. Description Required

22-01-04 
System Options for Incoming Calls - DIL No Answer 
Recall Time 

22-02-01 Incoming Call Trunk Setup 

22-04-01 Incoming Extension Ring Group Assignment 

22-07-01 DIL Assignment 

22-08-01 DIL/IRG No Answer Destination 

24-02-02 
System Options for Transfer - MOH or Ringback on 
Transferred Calls 

24-02-03 
System Options for Transfer - Delayed Call 
Forwarding Time 

80-03-01 DTMF Tone Receiver Setup  

80-04-01 Call Progress Tone Detector Setup  
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Setting Up Integration (SV8300)

SECTION 1 OVERVIEW

This chapter describes setup and programming for integrating the SV8300  
telephone system and the voice messaging system.

SECTION 2 SETTING UP INTEGRATION

Several tasks are required to integrate UM8000 with the phone system. 
Use the phone system programming interface (either a CAT phone or a 
SV8300 PCPro) to enter the phone system programming commands 
below.

Follow all the procedures in this section in the order presented.

2.1 Assign Extension Numbers to Voice Messaging Ports

Assign extension numbers to the voice messaging ports. The 
UM8000 blade occupies ports AABB01 to AABB08 for an 8-port 
system, and ports AABB01 to AABB16 for a 16-port system.        

2.2 Enabling Digital Voice Messaging Support

1. Enable AAInfo for incoming calls.   

Command Code: 1000

First Data: AABBXX
Where AA = Chassis,
BB = Slot,
XX = Port.

Second Data: Fxxx
Where F specifies a digital extension and 
<xxx> is the voice messaging port extension 
number.

NOTE

Repeat this command for each port on the UM8000 blade.

Command Code: 08

First Data: 702

Second Data: 0
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2. Enable CCIS for incoming calls.   

3. Enable AAInfo for transferred calls.   

4. Enable CCIS for MWI.   

5. Link VMS soft key feature and expand AAINFO.   

2.3 Assign Voice Messaging Ports as Digital Voice Messaging Ports

Designate all voice messaging ports as digital voice messaging ports.       

Command Code: 08

First Data: 703

Second Data: 0

Command Code: 08

First Data: 704

Second Data: 0

Command Code: 08

First Data: 706

Second Data: 0

Command Code: 08

First Data: 710

Second Data: 0

Command Code: 1324

First Data: xxx
Where <xxx> is the voice messaging port 
extension number.

Second Data: 0

NOTE

Repeat this command for each port on the UM8000 blade.
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2.4 Setting Up the UCD Hunt Group

1. Create a phantom extension number that will be the UCD pilot (master) 
number.   

2. Link the UCD pilot number to the first digital voice messaging extension.   

3. Link the first digital voice messaging extension number to the second 
digital voice messaging extension number, the second to the third, and so 
on.      

Command Code: 11

First Data: xxx
Where <xxx> is an unused port 
number.

Second Data: xxx
Where <xxx> is the UCD pilot 
extension

Command Code: 170

First Data: xxx
Where <xxx> is the UCD pilot 
extension number.

Second Data: xxx
Where <xxx> is the first digital voice 
messaging extension number.

Command Code: 170

First Data: xxx
Where <xxx> is the first digital voice 
messaging extension number.

Second Data: xxx
Where <xxx> is the second digital 
voice messaging extension number.

NOTE

Repeat this command, chaining each voice messaging extension to the next 
voice messaging extension. When you reach the last voice messaging 
extension number, link it back to the UCD pilot extension number created in 
Create a phantom extension number that will be the UCD pilot 
(master) number. (page 8-3).
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4. Assign the phantom extension number to the UCD pilot (master) number.   

5. Assign all UCD numbers to UCD group number 00.        

6. Make busy the UCD pilot extension number.   

7. Assign the UCD pilot (master) number to the tenant number.   

2.5 Enabling the Automated Attendant
To use the voice messaging system as an automated attendant, program the
phone system to send external calls to the UCD pilot (master) extension.

Command Code: 171

First Data: xxx
Where <xxx> is the UCD pilot 
extension number.

Second Data: 1

Command Code: 172

First Data: xxx
Where <xxx> is the extension 
number.

Second Data: 000

NOTE

Repeat this command for each voice messaging extension number and 
for the UCD pilot (master) number.

Command Code: E50

First Data: xxx
Where <xxx> is the UCD pilot 
extension number.

Second Data: 0

Command Code: 5115

First Data: 000

Second Data: xxx
Where <xxx> is the UCD pilot 
extension number.
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2.6 Setting Up Call Forward on Busy or Ring-No-Answer
To forward calls to the messaging system on busy or ring-no-answer, program
the individual extensions to forward calls to the UCD pilot (master) extension.  

2.7 Enabling Busy Greetings

1. Log on to the Web administration console, then go to Subscribers > 
Subscriber Template > Greetings.

2. Select Enable busy greeting.

3. Click Save.

2.8 Enabling Easy Message Access

Easy message access, also called direct message retrieval, is a feature that 
lets subscribers sign in quickly to the messaging system when dialing from their 
own extension. With this feature enabled and subscribers dial the messaging 
system they are immediately asked to enter their security code without having 
to enter their personal ID.

Easy message access is enabled by default for all subscribers.

However, this feature can be enhanced by configuring a line key on each 
subscriber’s phone that dials the messaging system automatically. To do this, 
program the phone system to allocate a key on each subscriber’s phone to dial 
the UCD pilot number.

2.9 Disabling Easy Message Access

1. Log on to the Web administration console, then go to System > Switch > 
Switch Information.

2. In the Integration options field, type EMA=0.

3. Click Save.

NOTE

To avoid creating a call forwarding conflict between the phone system and the 
messaging system, see About feature compatibility.
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2.10 Enabling Automatic Subscriber-to-Subscriber Messaging in 
Secured Mode

By default, automatic subscriber-to-subscriber messaging is enabled in 
unsecured mode for all subscribers. To enable this feature in secured mode, do 
this procedure.

1. Log on to the Web administration console, then go to System > Switch > 
Switch Information.

2. In the Integration options field, type ISM=2.

3. Click Save.

2.11 Setting Up Message Waiting Indication

By default, message waiting indication is enabled for all subscribers. Use the 
following procedure to verify MWI settings.

1. Log on to the Web administration console, then go to System > Switch > 
MWI.

2. Confirm that the On (activation) code and Off (deactivation) code fields 
contain an X.

3. Click Save.

2.12 Setting Up Automatic Number Identification (ANI)

To use ANI, you must activate the MF receiver built-in to the SV8300 CPU. 
Refer to the phone system documentation for details on setting up ANI.   

The phone system is now configured for basic digital integration.

NOTE

Setting up ANI overrides the Gather phone number call screening option, which asks 
callers to manually enter their phone number before routing the call.
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SECTION 3 SETTING UP SOFT KEYS

Use the phone system programming interface (either a CAT phone or a SV8300 
PCPro) to enter the phone system programming commands.

3.1 Enabling Soft Key Call Screening

Enable soft key call screening systemwide.   

3.2 Enabling the Voice Messaging Ports for Soft Keys

Enable all voice messaging ports for soft keys.        

SECTION 4 SETTING UP LIVE RECORD

A subscriber can record phone conversations using their phone or using ViewMail. For 
more information about ViewMail, see About Visual Messaging on page 84.

To record conversations using ViewMail, a barge-in code and executive override 
must be configured on the phone system, and call forward busy must be disabled 
on each phone extension recording from ViewMail. A barge-in code is a key 
sequence that the phone system dials to activate executive override (or silent 
monitor) to begin the recording. See your phone system documentation for more 
information.

To record conversations using a phone, the phone system and the subscriber’s 
extension must be configured properly. The procedures to do this are described 
later in this chapter.

Command Code: 08

First Data: 715

Second Data: 0

Command Code: 1337

First Data: <xxx>
Where <xxx> is the voice messaging port 
extension number.

Second Data: 0

NOTE

Repeat this command for each voice messaging extension on the UM8000 blade.
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While recording, a periodic beep is required by many local laws. To record from 
ViewMail, program the phone system to provide the periodic beep. To record from the 
phone set, configure the voice messaging system to provide the beep. The default is 
15 seconds. Entering 0 (zero) disables the beep. For instructions on how to set up the 
live record beep on the voice messaging system, see System Management Help.  

4.1 Configuring Live Record on the Phone System

1. Enable the live record beep.   

2. Enable automatic live record systemwide, optional.       

CAUTION

The use of monitoring, recording or listening devices to eavesdrop, monitor, retrieve or 
record phone conversations or other sound activities, whether or not contemporaneous 
with transmission, may be illegal in certain circumstances under federal or state laws. 
Legal advice should be sought prior to implementing any practice that monitors or 
records any phone conversation. Some federal and state laws require some form of 
notification to all parties to a phone conversation, such as using a beep tone or other 
notification methods or requiring the consent of all parties to the phone conversation, 
prior to monitoring or recording the phone conversation. Some of these laws 
incorporate strict penalties.

Command Code: 08

First Data: 109

Second Data: 0

Command Code: 08

First Data: 141

Second Data: 0
Where 0 enables automatic live 
record for systemwide and
1 disables automatic live record 
systemwide.

NOTE

Automatic live record is supported only with release transfers.
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3. Enable automatic live record for trunk calls, optional.   

4.2 Configuring Live Record on a Subscriber’s Extension

Do this procedure for each subscriber extension that will use live record.

1. Enable message waiting service for the extension.   

2. Set the Prime Line for the extension.   

3. Assign live record line key functions.    

Command Code: 3522

First Data: xx
Where <xx> is the trunk route 
number.

Second Data: 0
Where 0 enables automatic live 
record for systemwide and
1 disables automatic live record 
systemwide.

Command Code: 1303

First Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Second Data: 0

Command Code: 93

First Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Second Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Command Code: 9000

First Data: xxx, yyy
Where <xxx> is the subscriber’s 
extension number and
<yyy> is the line key.

Second Data: F1091
Where F1091 = Record.
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4. Enable automatic live record for the extension, if the subscriber wants it.   

4.3 Configuring Live Record on UM8000

By default, live record is disabled for subscribers in the default subscriber 
template and the maximum recording time for live record is 300 seconds, or five 
minutes. Use the following procedure to change the default  settings.

1. Log on to the Web administration console, then go to Subscribers > 
Subscriber Template > Live Record.

2. Select Enable live record.

3. In the Maximum record time field, specify the recording time in seconds.

4. Click Save.

5. If necessary, enable live record for any previously existing subscribers. 
The template change only affects new subscribers added to the 
messaging system.

Command Code: 1323

First Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Second Data: 0
Where 0 enables automatic live 
record for the extension and
1 disables automatic live record for 
the extension.
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SECTION 5 SETTING UP LIVE MONITOR

Subscribers can listen to a message as it is being recorded in their mailbox by using 
the live monitor feature. To monitor messages using a phone, the phone system and 
the subscriber’s extension must be configured properly. Use the phone system 
programming interface (either a CAT phone or a SV8300 PCPro) to enter the phone 
system programming commands.

5.1 Enable Live Monitor on the Phone System

Enable live monitor for the service restriction class.   

5.2 Configuring Live Monitor on a Subscriber’s Extension

Do this procedure for each subscriber extension that will use live monitor.

1. Set the live monitor mode for the subscriber’s extension.    

2. Enable live monitor pickup.   

Command Code: 15186

First Data: xxx
Where <xxx> is the service restriction class.

Second Data: 0
Where 0 enables live monitor and
1 disables live monitor systemwide.

Command Code: 1226

First Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Second Data: 0
Where 0 = automatic mode,
1 = manual mode and
3 = off.

Command Code: 1227

First Data: xxx
Where <xxx> is the subscriber’s 
extension number.

Second Data: 3
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3. Assign the live monitor line key function.        

5.3 Enabling Live Monitor on UM8000

By default, live monitor is disabled for subscribers in the subscriber template. To 
enable live monitor in the subscriber template, use the following procedure.

1. Log on to the Web administration console, then go to Subscribers > 
Subscriber Template > Access Options.

2. Under Administration, select Enable Live Monitor.

3. Click Save.

4. Enable live monitor for any previously existing subscribers.

Command Code: 9000

First Data: xxx, yy
Where <xxx> is the subscriber’s 
extension number and
<yy> is the line key.

Second Data: F5024

NOTE

After programming is finished, the user at the extension must go 
off-hook (press the Speaker button), then press the key that was 
programmed for live monitor in step 3. The LED will turn red and live 
monitor is ready for use.
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Configuring UM8000

SECTION 1 OVERVIEW

Once the UM8000 blade has been installed, the next step is to configure 
the voice messaging system and the SV8100/SV8300 phone system to 
communicate with each other.

SECTION 2 STARTING THE UM8000 FOR THE FIRST TIME

To start the UM8000 for the first time, make the required settings and 
license agreements before starting the application.  To access settings 
options and license agreements, connect to the Web Administration 
Console (WAC) using an internet browser.  

If the license agreements are not accepted, the application cannot start.   

The following procedure provides instructions for starting the UM8000 for 
the first time:

1. First determine the IP address of the voice mail by checking program 
10-55-01 for the slot where the blade is installed.

2. Start your internet browser and enter the IP address followed by 
/admin in the URL window.  

For example:  172.16.0.100/admin.

3. Press <ENTER>.

NOTE

If the voice mail database is defaulted, this procedure must be repeated.
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4. If prompted with a certificate warning, accept the certificate and choose to 
continue to web page.  Then log into the WAC with the user name: $nec. 
No password is required. 

Figure 9-1  UM8000 Login
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5. You are prompted to accept the third party software license agreement.

Figure 9-2  Third Party Software License Agreement
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6. Choose the phone system where the voice mail is to be installed. 

Figure 9-3  UM8000 Switch Information
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Figure 9-4  UM8000 Integration Options
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7. Set the extension numbers that are assigned to the voice mail in program 
11-02-01.  Select  Edit All.  Enter the extension number for each voice mail port, 
then click Save. 

Figure 9-5  Entering Switch Extensions for Voice Mail Ports, Screen 1
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Figure 9-6  Entering Switch Extensions for Voice Mail Ports, Screen 2
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8. To register the equipment at this time, enter the registration information on the 
Product Registration Form screen.  The voice mail must have access to the 
internet for the registration to be successful.  You can also choose not to register 
at this time or to be reminded in seven days.

Figure 9-7  Product Registration Form
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9. You are now logged into the WAC, but the application is not yet started.

Figure 9-8  System Information 
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10. Start the application by going to Server Control and clicking on the Start icon.

SECTION 3 CONFIGURING THE VOICE MESSAGING SYSTEM

Configuring the voice messaging system is managed using two tools: the Maintenance 
Menu and the Web administration console. The Maintenance Menu is a graphical user 
interface that minimizes the need to type lengthy commands at the command line 
prompt. 

Maintenance Menu – Use the Maintenance menu to specify network DNS 
configuration settings, apply system updates and for general tone detection.

Web administration console – Use the Web administration console to set 
hospitality (Property management system - PMS) settings, e-mail integration 
settings, add/remove language packs, extension remapping, trunk remapping, 
update licensing information, specify switch integration information, and much 
more. Refer to System Management Help for details about other functionality 
available in the Web administration console.

Figure 9-9  Server Control Start Icon
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SECTION 4 BEFORE SHIPPING THE VOICE MESSAGING SYSTEM

Resellers who are assembling voice messaging systems for delivery to customers 
must reset the third-party licensing agreements. This enables the customers to accept 
the licensing for third-party software that is installed with the voice messaging system.

The IP address for the voice mail is assigned in chassis programming 10-55-xx.  At 
default this address is 172.16.1.xxx, where .xxx will vary depending upon which slot the 
CD-VM00 was installed.  Starting with slot 1 this will be .100, slot 2 will be .101, slot 5 
will be .104 and so on.  

4.1 Resetting Third-Party Licensing Agreements

To reset:

1. Start PuTTY.

2. Log on as admin. 

3. Type the password, voicemail. 
The Main menu appears. 

4. Choose 2-Maintenance, then press <ENTER>. 

The Maintenance menu appears. 

5. Choose 3-Command prompt, then press <ENTER>. 

6. Type sudo  /opt/vmail/bin/prepare_system <ENTER>.  

The first time the client starts the Web administration console, the licensing 
agreements are displayed. 

CAUTION

Law requires that end-users accept the End User License Agreement for software 
installed on their systems. 
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SECTION 5 SETTING UP THE UM8000 SOFTWARE

After installing and connecting to the UM8000 blade, configure the voice blade and 
voice messaging software features.

5.1 Configuring Network Setup

The following network information is required to configure the network setup. 

Use the following procedure to specify the network setup. 

5.2 Specifying the Network Setup

The IP address for the voice mail is assigned in chassis programming 10-55-xx.  
At default this address is 172.16.1.xxx, where .xxx will vary depending upon 
which slot the CD-VM00 was installed.  Starting with slot 1 this will be .100, slot 
2 will be .101, slot 5 will be .104 and so on.  

The DNS server IP Address, Host Name and Domain Name are all that can be 
configured from the Maintenance Menu.

To specify the setup:

1. Start PuTTY. 

The login prompt appears.

2. Type admin <ENTER>.

3. Type the password: voicemail <ENTER>.

The Main menu appears. 

The following network information is required to configure 
the network setup.

Host name or IP address

Domain name

Primary DNS IP address

Secondary DNS IP address

TCP/IP
Minimum required to provide access to Web administration 
console and Maintenance menu (PuTTY). 

IP address

Subnet mask

Default gateway



UM8000 Issue No. 1.0

Installation Manual 9 - 13

4. Choose 1 Configuration, then OK. 

The Configuration page appears. 

5. Choose 1 Network setup, then OK. 

6. The Network setting page appears. 

7. Choose 1 Host name, then OK. 

The Host name page appears. 

8. Type the Host name, the choose OK. 

The Network setting page reappears. 

9. Choose 2 Domain name, then OK. 

The Domain name page appears. 

10. Type the Domain name, then choose OK. 

The Network setting page reappears. 

11. Choose 3 Primary DNS, then OK. 

The Primary DNS page appears. 

12. Type the DNS server IP address, then choose OK. 

The Network setting page reappears. 

13. Choose 4 Secondary DNS, then OK. 

The Secondary DNS page appears. 

14. Type the DNS server IP address, then choose OK. 

The Network setting page reappears. 

5.3 Setting Up UM8000 Date and Time

The UM8000 Mail automatically synchronizes its time and time zone with the 
phone system time on boot up.  Manual adjustments on the voice mail are not 
needed or available.
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5.4 Changing Administrator Password and Creating a New User

5.4.1 Changing the Password

To change admin password, use the following procedure.

1. Start PuTTY. 

2. Log in as Admin <ENTER>.

3. On the Main menu, choose 2-Maintenance, then press <ENTER>. 

The Maintenance page appears. 

4. On the Maintenance menu, choose 2-Set admin password, then 
press <ENTER>. 

The Set admin password page appears. 

5. Type the new password, then press <ENTER>.

6. Retype the new password., then press <ENTER>.

An alert message appears stating that the password has been 
changed.

7. Click OK or press <ENTER> to return to the Maintenance menu.

8. On the Maintenance menu, choose 0-Return to previous menu, then 
press <ENTER> to return to the Main menu. 

5.4.2 Creating a New User

To create a new system manager for the voice messaging system, 
perform the following procedure: 

1. Start the Web administration console. 

2. Under Subscribers, click Subscribers.

The Subscriber profile page appears. 

3. Click the Add icon to create a new subscriber. 

The Add subscriber page appears. 

4. Make sure that the New subscriber check box is checked. 

5. Click Add. 

The Add subscriber page resets. Close the page.

6. On the Subscriber profile page, choose the Enable subscriber as 
system manager check box.  

7. Click the Save icon. 

8. The new subscriber now has system manager permissions.
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E-mail Integration

SECTION 1 OVERVIEW

This chapter explains how to set up e-mail integration for the voice 
messaging system, and how to set up e-mail features for subscribers.

Subscribers can use text-to-speech technology to listen to e-mail 
messages by phone. E-mail message counts can be included in new 
message counts. All voice messages and faxes can be forwarded to e-mail 
inboxes.

The e-mail integration provides 24-hour access to e-mail from any 
touchtone phone. Standard protocols are used to access, read, and send 
e-mail messages on the voice messaging system. The protocols for 
integration include IMAP and MIME. 

The e-mail server must support the SMTP protocol for outgoing e-mail 
features to work properly.

SECTION 2 PROTOCOLS

2.1 E-mail Protocols

The following standard e-mail protocols ensure the successful 
transmission of e-mail messages: 

IMAP – Internet Message Access Protocol (IMAP) provides 
the voice messaging system access to e-mail inboxes. 

The voice messaging system uses IMAP to obtain e-mail 
message headers and body information from a variety of 
e-mail servers. This information is delivered to the text-to-
speech engine to convert the text to audio format for playback.

NOTE

Text-to-speech does not support HTML encoded messages. If HTML tags 
are heard during message playback, the message is skipped. HTML 
messages must be encoded using multipart MIME for text-to-speech to 
work properly. 
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MIME – Multipurpose Internet Mail Extensions (MIME) provides the voice 
messaging system the capability to read e-mail message header and 
body information. 

Multipart MIME messages enable the e-mail system to send enhanced 
versions of the message for messaging clients such as Lotus® Notes and 
Microsoft Outlook. Multipart MIME messages contain plain text messages 
that can be read to subscribers over the phone.

POP3 – Post Office Protocol and Authenticated Post Office Protocol. 
POP3 is a standard internet protocol used for retrieving Internet e-mail 
and is used by the e-mail client to communicate with SMTP mail servers. 
With POP3 the user name and password are sent across the network in 
clear text. With APOP, the password is encrypted before being transmitted 
over the network to the SMTP mail server.

SMTP – Simple Mail Transport Protocol (SMTP) provides the voice 
messaging system the capability to send outgoing e-mail messages. The 
system forwards voice mail and faxes to the e-mail system, receives e-
mail notification of new fax/voice mail, and uses voice mail features to 
reply to e-mail messages. SMTP can be configured to restrict the type of 
messages sent such as only allowing SMTP mail to be sent to other users 
on the same domain. 

2.2 Subscriber E-mail Authentication Protocols

PLAIN – PLAIN is a simple clear text password mechanism. The 
mechanism uses a user name and password to authenticate users. 

NTLM – NTLM is a challenge-response authentication protocol.  The 
server authenticates the client by sending an 8-byte random number, the 
challenge. The client performs an operation involving the challenge and a 
secret shared between client and server, e.g. a password. The client 
returns the 24-byte result of the computation. In fact, in NTLMv1 two 
computations are made using two different shared secrets and two 
24-byte results are returned. The server verifies that the client has 
computed the correct result, and from this infers possession of the secret, 
and hence the identity of the client.

LOGIN – The LOGIN mechanism is a non-standard mechanism, and is 
similar to the PLAIN mechanism except that LOGIN lacks the support for 
authorization identities.
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SECTION 3 E-MAIL INTEGRATION SET UP

The following is a summary of the steps required to set up the e-mail integration.

1. Configure the voice messaging system server.
Set up the information for the outgoing e-mail server connected to the voice mes-
saging system. 

2. Configure the e-mail server.
The e-mail server must be configured to properly integrate with the voice mes-
saging system.  

Supported e-mail servers are:

Microsoft® Exchange 2000 or 2003
Lotus® Domino™ 6.0, 6.5, or 7.0
Novell GroupWise® 6.0, 6.5 or 7.0 

Refer to the appropriate e-mail server documentation to configure the e-mail 
server. 

3. Set up subscribers.
After the e-mail server and the voice messaging system have been configured, 
configure subscriber mailboxes to access e-mail. 

SECTION 4 CONFIGURING THE E-MAIL SERVERS

The e-mail server must have SMTP, POP3 and IMAP enabled to use the e-mail 
integration. 

To enable SMTP and IMAP refer to the e-mail server documentation or consult the 
system administrator about which settings are appropriate for the organization.  

4.1 Setting the E-mail Server Configuration

The following configuration settings must be set for the e-mail server.  

WARNING

The e-mail administrator is required to configure the e-mail server.

WARNING

The e-mail administrator is required to configure the e-mail server.

E-mail Server Required Protocols

Microsoft Exchange IMAP, MIME, PLAIN, and LOGIN for outgoing messages

Lotus Notes Domino IMAP, PLAIN, and LOGIN for outgoing messages

GroupWise IMAP4, PLAIN, and LOGIN for outgoing messages, SMTP 
Relay - Allow message relaying
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4.2 Converting Existing Domino E-mail Files for Users

Set an Internet password for all existing users before converting any existing 
e-mail files. Use the following procedure to convert user e-mail files.

4.2.1 Converting Existing E-mail Files 

1. Log on to the Domino e-mail server as root user. 

2. On the Windows taskbar, click Start > Programs > Lotus 
Application > Lotus Domino Administration.

3. Type the Domino password.

The Domino Administrator console appears.

4. Click Console to open the Domino server command prompt. 

The command prompt appears. Use one of the following set of 
commands to convert existing e-mail:
■ To convert a single user, type the following commands:

tell router quit
load convert -e mail\<mailfilename>.nsf
load convert -h mail\<mailfilename>.nsf
load router

Where <mailfilename> is the name of the user, follow these 
steps for each user to be converted.
■ To convert all users in a directory, type the following 

commands:
tell router quit
load convert -e mail\*.nsf
load convert -h mail\*.nsf
load router

5. Close the Domino Administrator. 

6. Log off the Domino server. 

The Domino server is now configured for e-mail integration. 

SECTION 5 CONFIGURING THE VOICE MESSAGING SYSTEM

The e-mail server must be configured and connected to the voice messaging system 
before subscribers can use the e-mail integration. 

The following e-mail server information is required to establish communications with 
the voice messaging system server:

The IP address or exact name of the SMTP server.

The SMTP port number.
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5.1 Configuring the Voice Messaging System for E-mail Integration

1. Start the Web administration console.

2. Under System, click Configuration > E-mail settings. 

3. In the Outgoing e-mail server field, type the IP address of the outgoing e-
mail server. 

If the system is set up to recognize server names, type the server name 
instead of the IP address. 

4. In the Port field, type the SMTP port for the e-mail server. The default port 
is 25. 

If the Secure Sockets Layer (SSL) protocol is used, click the SSL check 
box. 

5. In the Authentication field, select the authentication protocol used by the 
e-mail server. 

6. Type the user name.

7. Type a password. 

8. In the Global e-mail field, type the common e-mail address used for all 
outgoing e-mail. 

9. In the Display name field, type the common display name used for all 
outgoing e-mail. 

10. Click the Save icon.

The voice messaging system e-mail configuration is complete. 

5.2 Configuring the E-mail Notification Template

1. Start the Web administration console.

2. Under System, click Configuration > E-mail message template. 

The e-mail message template page appears. 

3. The default language is automatically selected in the Language field. 
Select the a different language from the drop-down list. 

4. In the Notification type field, select the default notification type.

● Voice notification ● Fax notification

● Message copy ● Forward voice

● Forward fax ● Forward fax with voice

● Reply voice ● Reply fax

● IM
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5. Construct the notification template as needed.  The tags below can be 
used to insert information that the voice mail system dynamically 
determines for each message.

6. Click the Save icon.

7. Click Preview. 

The voice messaging system e-mail configuration is complete. 

Next step…
◆ Configure subscriber template e-mail settings.  Refer to Section 6.1 Setting 

Up the Default Subscriber Template on page 10-7 in this chapter.

● [senderName] ● Sender's name

● [senderPhone]  ● Sender's phone

● [senderAccount] ● Sender's account (only available if 
configured in subscriber transfer/
screening options) 

● [messageTimestamp] ● Message received timestamp on 
the messaging system 

● [messageDuration] ● Message length in seconds 

● [messageSize] ● Message size in kilobytes 

● [messageFlag] ● Message Special flags. Available 
message flags: PRIVATE and 
URGENT 

● [voicemailURL] ● URL of the messaging system 

● [subscriberName] ● Subscriber's name 

● [subscriberExtension] ● Subscriber's extension 

● [notificationType] ● Message notification type. Available 
notification types: voice, fax, 
message copy, forwarded voice, 
forwarded fax, forwarded fax with 
voice, reply fax, reply voice and IM 
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SECTION 6 SETTING UP SUBSCRIBER MAILBOXES

After configuring the voice messaging system server and the e-mail server for e-mail 
integration, set up subscribers to access e-mail messages using the phone.

6.1 Setting Up the Default Subscriber Template

Configure the subscriber template for access to e-mail. The subscriber template 
is used to pre-configure new subscriber settings. Any existing subscribers must 
be configured individually. 

To set up the default subscriber template, perform the following procedure:

1. Start the voice messaging system.

2. Start the Web administration console.

3. Under Subscribers, click Subscriber Template > E-Mail.

4. In the Server type field, choose IMAP or POP3. 

5. In the Server name field, type the IP address for the voice messaging 
system. 

Choose authentication method Plaintext or NTLM.

6. If appropriate, make sure the Use SSL check box is checked, for SSL 
authentication.

7. When the SSL check box is checked, the port number 993 appears in the 
field. 

8. In the Port field, type 143 for IMAP; 110 for POP3; or the appropriate 
value for the e-mail server. 

9. Click the Save icon.

6.2 Setting Subscriber E-mail Options

Use the following procedure to change individual subscriber e-mail settings. 

To set subscriber e-mail access options:

1. Start the Web administration console.

2. In the Subscribers section, click Subscriber Template > E-Mail.

3. Select a subscriber. 

Use the Next, Previous, or Find Subscriber icons to locate a subscriber 
profile. The subscriber profile is displayed. 

NOTE

For subscriber e-mail integration to work, the subscriber must have 
appropriate access options. Access to e-mail messages from voice mail 
or fax/voice e-mail forwarding or notification. 
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4. Click E-mail.

The subscriber e-mail settings appear.

5. In the e-mail address field, type the subscriber full e-mail address. For 
example: name@company.com. 

6. Choose a Server type from the drop-down list: POP3 or IMAP. 

7. In the Server name field, type the server IP address or server name. 

8. In the User name field, type the subscriber system ID used to attempt 
authentication with the e-mail server. For example: POP access requires 
a full e-mail address, while Microsoft Exchange server with IMAP does 
not. 

9. If appropriate, make sure the Use SSL check box is checked, for SSL 
authentication.

When the SSL check box is checked, the port number 993 appears in the 
field. 

10. In the Port field, type 143 for IMAP; 110 for POP3; or the appropriate 
value for the e-mail server. 

11. If the e-mail system uses authentication, check the Use authentication 
check box, then choose the authentication type from the drop-down list. 

12. Click the Save icon.

Repeat this procedure for each existing subscriber. Use the Next, Previous, or 
Find Subscriber icons to display the subscriber profile. 

Next step…
◆ Test the e-mail integration. 

NOTE

For subscriber e-mail integration to work, the subscriber must have 
appropriate access options. Access to e-mail messages from voice mail 
or fax/voice e-mail forwarding or notification. 
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Remote Maintenance

SECTION 1 OVERVIEW

Remote maintenance enables administrators to use a remote computer to 
troubleshoot and maintain the voice messaging system. Remote 
maintenance uses the Internet and a network LAN connection or a dial-up 
connection.

Internet and network access requires that the voice messaging system is 
connected to a network that provides Internet access. The network 
administrator must also set up the firewall to enable remote access. To 
access the voice messaging system remotely, the IP address must be 
statically mapped to an outside IP address on a per IP address or a per 
TCP port basis.

Dial-up access requires both the voice messaging system and remote 
computer to have modems set up and accessible. Dial-up Networking must 
be configured on the remote computer and the remote computer must have 
an SSH client installed.

SECTION 2 SETTING UP DIAL-UP MAINTENANCE

The remote computer must have Windows dial-up networking properly 
configured before attempting to connect to the voice messaging system. 

To configure dial-up maintenance for the voice messaging system, perform 
the following procedure:

1. From the Main Menu, go to System> Configuration > Access 
Number.

2. Specify the internal modem extension (default:  663). 

3. Click on the Save button.

NOTE

This is the extension you must dial to establish a remote modem connection with 
the voice messaging system.
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2.1 Setting Up the Remote Computer Dial-up Networking

The following procedure is written for a remote computer that is running the 
Windows XP operating system. Use the following procedure to configure the 
dial-up networking. 

Refer to the network configuration documentation if a different operating system 
is installed on the remote computer. 

1. To set up dial-up networking on a remote computer

2. Click Start > My Network Places > Properties.

The Network connections properties window appears.

3. Double-click New Connection Wizard. 

The New Connection Wizard Welcome page appears.

4. Click Next.

5. Select Connect to the network at my workplace, then click Next.

6. Select Dial-up connection, then click Next.

7. Type a name for the connection. For example, type UM8000, then click 
Next.

8. Type the phone number for the modem at the remote site, then click Next.

9. Select the My use only connection option, then click Next. 

10. Select the Add a shortcut to this connection to my desktop check box, 
then click Finish.

The New Connection Wizard places a shortcut icon on the desktop and 
closes. 

SECTION 3 USING A REMOTE COMPUTER

A remote computer that is running a different operating system can be used to access 
the voice messaging system. The TCP/IP settings on the remote computer must be set 
to connect to the default IP address for the voice blade. 

3.1 Configuring TCP/IP

This procedure assumes that a network card is installed and correctly 
configured on the remote computer running the Windows XP operating system. 

3.1.1 Configuring TCP/IP for the Remote Computer

Refer to the system documentation for information about configuring 
the TCP/IP settings for a remote computer that is running a different 
operating system. 

1. On the Windows desktop, click Start.
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2. Right-click My Network Places, and select Properties.

The Network Connections window appears. 

3. Right-click Local Area Connection, then select Properties.

The Local Area Connection Properties window appears.

4. Double-click Internet Protocol (TCP/IP).

5. On the General tab:
a Select Use the following IP address.
b Type 172.16.1.200 in the IP address field.
c Type 255.255.255.0 in the Subnet mask field.
d Leave the Default gateway field blank.
e Click OK. 

The Internet Protocol properties dialog box closes.

6. Click OK to close the Local Area Connection window.

3.2 Using Dial-up Connection

The procedures in this section assume that the network administrator has 
helped set up the remote computer for remote dial-up access and that you 
know how to dial-in to the network. 

3.2.1 Using WinSCP and Dial-up to Connect Remotely

Use the following procedure to transfer files between the voice 
messaging system and a remote computer. 

1. On the Windows Desktop, double-click the Dial-up connection 
icon. 

The Connect page appears. If you are using a network connection, 
go to step 6.

2. In the User name field, type admin.

3. In the Password field, type the password: voicemail.

4. Click Dial. 
The modem dials the phone number. If the connection is 
successful, a small icon with two flashing computers appears On 
the Windows taskbar. 

5. On the Windows taskbar, click Start > Programs > WinSCP3 > 
WinSCP. 

The Login window appears.

NOTE

Consult your network administrator for assistance setting up 
dial-up access to the network.
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6. Type the Host name or IP address of the voice messaging 
system.  Verify new remote maintenance IP addresses.

If dial-up is being used, type 10.0.0.1. 

7. Type the User name, admin. 

8. Type the Password, voicemail. 

9. Under Protocol, select SFTP (allow SCP fallback).

10. Click Login. 

When the first connection is made, a warning message appears. 
This message does not appear for subsequent connections. Click 
Yes. 

After authentication is complete, the WinSCP File Transfer page 
appears.

3.2.2 Transferring Files to the Remote Computer

This procedure assumes that the Norton Commander interface has 
been selected. The Norton Command interface displays the source 
directory structure in the left pane and the destination directory in the 
right pane. This enables the use of drag and drop to copy files. 

1. Select the file or files to copy. 

2. Right-click the file name, then select Copy. 

Alternatively, if the Norton Commander interface is active, you can 
drag and drop files.

3.2.3 Transferring Files from the Remote Computer 

1. Select the file or files to copy. 

2. Click Files > Copy, then click Copy. 

Alternatively, if the Norton Commander interface is active, you can 
drag and drop files.

3.3 Logging On and Logging Off Using PuTTY

Log on and log off after connecting to the UM8000 blade.

3.3.1 Logging On Using PuTTY

1. Click Start > Programs > PuTTY > PuTTY.

The PuTTY configuration dialog box appears.

2. Type the Host name of the voice messaging server, then click 
OPEN. 

The PuTTY client shell appears with a login as prompt.
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3. At the login prompt, type admin <ENTER>.

The Maintenance menu appears in a PuTTY window.

4. When prompted for the password, type voicemail <ENTER>.

The Maintenance menu appears when the correct password is 
typed.

3.3.2 Changing the Admin Password

Changing the support password secures the computer at the 
operating system level. The system manager should take additional 
steps to secure UM8000 at the voice messaging application level. 
Refer to System Management Help for more information.

This procedure assumes that the mouse is used as an input device. 

1. On the Maintenance menu, click 2 Maintenance, then click OK.

The System maintenance menu appears.

2. On the System maintenance menu, click 2 Set admin 
password, then click OK.

The Set admin password window appears.

3. Type the new password, then click OK.

4. When prompted, retype the new password, then click OK.

A message appears stating that the password has been changed.

5. Click OK to return to the System maintenance menu. 

6. Click 0 Return to previous menu, then click OK to return to the 
Maintenance menu. 

7. Click 0 Log out, then click OK to log out and close the PuTTY 
window.

3.3.3 Logging Off 

To log off from the operating system, do the following:

3.3.3.1 Logging Off Using PuTTY

1. Return to main Maintenance menu screen.

2. Choose 0 Log Out, then choose OK.
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SECTION 4 SINGLE POINT OF ENTRY

When connected to the SV8100 using WebPro or PCPro you have the ability to 
connect directly to the UM8000 Web Admin Console (WAC).  The SV8100 knows if the 
UM8000 is installed and running and also knows the IP address assigned to it.  Other 
than normal system programming for the UM8000, no configuration changes are 
required.

The instructions below show how to connect to the UM8000 from PCPro or WebPro 
after you have connected to the SV8100 system.  The UM8000 must be connected to 
the same LAN as the SV8100 CPU.

4.1 Using WebPro

1. Log in to the SV8100 with user name = tech and password = 12345678.

Figure 11-1  WebPro Login
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2. Once logged in, the main screen has a link to the “In-Skin Voice Mail”, if 
the UM8000 is installed and working.

3. WebPro automatically launches your default web browser and connects to 
the UM8000

Figure 11-2  WebPro Connection to In-Skin Voice Mail
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4. When prompted, accept the web browser security warning..

Figure 11-3  WebPro Security Certificate Warning
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5.  You are now logged into the WAC.

Figure 11-4  WebPro Web Admin Console
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4.2 PCPro

1. Start PCPro and login with user name = tech and password = 12345678.    

2. Open the site’s database.  If the database is not available, connect to the 
SV8100 and download the database before continuing.

3. While connected to the SV8100, chose Links/In Skin Voice Mail Server.

4. PCPro  automatically launches the default web browser and connects to 
the UM8000.

Figure 11-5  PCPro Login
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5. When prompted, accept the web browser security warning. .

Figure 11-6  Web Browser Security Certificate Warning
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6.  You are now logged into the WAC.

Figure 11-7  Web Admin Console
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Backing up and Restoring UM8000

SECTION 1 BACKING UP THE VOICE MESSAGING DATA

The voice messaging database can be backed up on a regular basis using 
the backup and restore utilities. The backup and restore utilities are 
installed on the voice messaging server.

The back up and restore utilities are run from the Web Admin Console 
(WAC). The WAC provides a GUI driven user interface that replaces the 
need to type Linux commands in a shell.

There are two types of backups: 

o Daily – The utility backs up the selected components every night at 
2:00 a.m.  The database can be saved on the voice mail or on a 
shared Windows network drive.

o Manual – The utility backs up the selected components immediately 
to either the voice mail drive or a shared Windows network drive.

SECTION 2 BACKING UP AND RESTORING UM8000 MAIL DATABASE

Backups can be done manually or daily.  They are saved with the entered 
file name in zip format.  You can choose to save the backup on the voice 
mail hard drive, a USB drive or a Windows shared folder.  

Backups to the hard drive are stored on the voice mail and can be 
downloaded.  Backups to a USB drive are stored on the USB drive.  
Backups to a Windows Shared Folder are not stored on the voice mail.

2.1 Backing Up the UM8000

2.1.1 Performing a Manual Backup

For a manual backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Backup.

3. Under Manual backup, if the messages should be 
included in the backup check the Include messages 
in backup box.

CAUTION

If a USB memory stick drive will be used for backup storage, connect it 
before starting the backup.
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4. Choose the drive from the Backup Destination pull down menu:

If backing up to the Hard Drive on the support PC, choose Hard 
Drive.

If backing up to a USB drive, the drive will show up as an option 
with the name of the drive manufacturer.  For example, it might 
show as PNY.

If backing up to a Windows shared drive, choose Windows 
Shared Folder.  If choosing a Windows Shared Folder, you will 
need to know the path to the share (Example: //myComputer/
shareName) and the log in information (domain, user name, 
password).

5. Enter the file name to be used for this backup.

6. Enter any comments needed for this backup.

7. Click the backup now icon.

8. The time to backup the database is determined by the size of the 
system and number of messages that must be saved.

2.1.2 Enabling Daily Backup

For a daily backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Backup.

3. If the messages should be included in the backup check the box, 
Include messages in backup.

4. Choose the drive from the Backup Destination pull down menu:

If backing up to the Hard Drive on the support PC choose Hard 
Drive.

If backing up to a USB drive the drive will show up as an option 
with the name of the drive manufacturer.  For example it might 
show as PNY.

If backing up to a Windows shared drive choose Windows 
Shared Folder.  You must also enter the path to the shared 
folder, the user name and password, if needed.  If choosing a 
Windows Shared Folder you will need to know the path to the 
share (Example: //myComputer/shareName) and the log in 
information (domain, user name, password).

5. If any changes were made, click the save icon.

NOTE

It is recommended that a USB drive NOT be used for daily backup.
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2.1.3 Downloading a Backup Stored on the Voice Mail Drive

To download a backup stored on the voice mail drive, perform the 
following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu choose Download.

4. If prompted by the Internet browser, choose to allow the 
download.

5. Choose to Save the backup zip file.

6. Browse to the location where the file is to be downloaded on the 
support PC.

7. Click Save.

2.2 Restoring a Database Back Up to the UM8000

2.2.1 Uploading a Stored Backup to the Voice Mail Drive

To upload a stored backup to the voice mail drive, perform the 
following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. Under Upload an existing backup to the messaging system, click 
on browse.

4. Browse to the location where file is to be stored on the support 
PC.

5. Click Upload File.

2.2.2 Restoring a Previous Backup

To restore a previous backup, perform the following steps:

1. Log in to the Web Admin Console (WAC).

2. Go to Server Control.

3. If started, choose to stop the server.

4. Go to System/Backup and Restore/Restore.

5. In the Action pull down menu, choose Restore this backup.

6. If the backup has messages, confirm you want the messages 
restored with the database.
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7. Go to Server Control.

8. Choose to start the server.

2.2.3 Deleting a Stored Database Backup

To delete a stored database backup, perform the following steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu, choose Delete.

4. Confirm you want to delete the backup file. 

2.2.4 Viewing Notes for a Stored Database Backup

To view notes for a stored database backup, perform the following 
steps:

1. Log into the Web Admin Console (WAC).

2. Go to System/Backup and Restore/Restore.

3. In the Action pull down menu, choose View backup note.

4. The note shows as a pop up window.

5. After reading the note, click OK to close the window. 
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Database Migration

SECTION 1 MIGRATING FROM OS/2

1.1 About Migration

UM8000 supports migration from previous products. This chapter 
describes the steps required to migrate data from DOS, OS/2 and 
Linux based voice messaging systems to the UM8000 Mail. 

Migration of most existing data from OS/2 voice messaging system 
to a new UM8000 system is possible. The data includes the system 
configuration settings, subscriber accounts, groups, transaction 
boxes, interview boxes, voice names and greetings, and messages. 

On the UM8000 system, verify that the prompt set configuration is 
identical to the prompt set configuration of the OS/2 based voice 
mail system. Otherwise, language settings might not migrate 
properly.

1.2 Backing Up Data Locally

After the backup is complete, compress the files in the proper 
format to migrate to UM8000. This requires transferring a 
compression utility to the OS/2 voice messaging system blade. 

1.2.1 Compressing the OS/2 Backup Data

The following procedure uses CoSesssion to compress 
the data, but FTP to transfer the compression utility if the 
OS/2 FTP server is already configured.

To compress the OS/2 voice messaging system backup 
data, perform the following procedure:

1. On the remote support computer, insert the UM8000 
support disc into the disk drive.

2. Using the CoSession client, connect to the OS/2 
voice messaging system.

3. Browse to the file PKOS2250.EXE on the support 
disc and transfer it to the E:\ directory on the OS/2 
blade.

4. Open a command prompt window on the OS/2 
system.

NOTE

Customized prompts cannot be migrated.
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5. Change to the E drive. Type E: <ENTER>

6. Type cd\, then press OK.

7. Type mkdir archive <ENTER>. 

8. Type move PKOS2250.EXE \archive <ENTER>. 

9. Type cd archive <ENTER>. 

10. Type PKOS2250.EXE <ENTER>. 

11. The program extracts the PKZIP.EXE utility to the E:\archive 
directory.

12. Type cd \backup <ENTER>. 

13. To compress the backup file type:
\archive\pkzip /add /dir=current E:\backup.zip <ENTER>
Where backup.zip is the name of the compress file. 

This completes the local backup and compression process.

1.2.2 Transferring Backup Files

After completing a local backup and compressing the backup files, 
transfer the files from the OS/2 voice messaging system to another 
computer for temporary storage. 

There are two methods for transferring the files: 

FTP connection
The UM8000 system is set up for networking. 

CoSession
The OS/2 voice messaging system is connected to a remote 
computer using a direct-connect null modem cable. 

1.2.3 Using FTP to Transfer Files

An FTP connection requires a network connection to a Windows 
computer. Set up the OS/2 voice messaging  FTP server before 
transferring the files.

1.2.3.1 Setting Up the OS/2 FTP Server

To set up the OS/2 FTP server:

1. Use CoSession to connect to the OS/2 voice 
messaging system.

2. At the OS/2 command prompt, type c: <ENTER>.

3. Type cd \mptn\etc <ENTER>.
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4. Open a text editor. Type e TRUSERS <ENTER>.  

This command creates a new file, TRUSERS and 
opens the text editor.

5. Type the following lines into the file:

user support voice 
rd e:\
wr e:\ 

6. Save the file and exit the text editor.

7. Start the OS/2 FTP server. Type c:\tcpip\bin\ftpd 
<ENTER>.

1.2.3.2 Transferring the Backup File Using FTP

To transfer the backup file using the FTP server:

1. At the Windows computer, open a command prompt 
window and type 

ftp <IP address> <ENTER>
where <IP address> is the IP address of the OS/2 
voice messaging system.

2. When asked for the user name, type support 
<ENTER>.

When asked for the password, type voice <ENTER>.

3. Type lcd <directory name> t <ENTER>.

Where <directory name> is the destination directory 
on the Windows computer where the compressed 
backup file will be stored.

4. Type binary <ENTER>.

This sets the file transfer mode to binary.

The file transfer mode must be set to binary or the 
migration will fail.

5. Type get <filename> <ENTER>.

NOTE

The file name must be TRUSERS without a file 
extension.
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Where <filename> is the name of the compressed 
backup file, for example backup.zip. If the file transfer 
is successful, you should see the following message: 
File send OK. 

6. To exit the FTP client, type quit <ENTER>.

Next steps…
◆ Migrate the OS/2 data to the UM8000 

database.  Refer to 1.3 Migrating the Backup 
Data on page 13-4.

1.3 Migrating the Backup Data

After the OS/2 backup data has been transferred to the UM8000 system, start 
the migration. 

To migrate the OS/2 data to the UM8000 database, perform the following 
procedure:

1. Log into the Web Administration Console.

2. Go to System/Backup and Restore/Restore.

3. Use the browse icon to find the database to migrate on the support PC, 
this can include mapped network drives.

4. Choose upload.

After uploading the database, it appears in the local backup list.

5. In the pull down menu for the uploaded database, choose restore.

6. When prompted, confirm to restore this database.

7. When the migration completes, you receive a message.

8. Go to Server Control.

9. Stop the voice messaging system.

10. After the application stops, choose to start the voice messaging system.

NOTE

File names are case-sensitive when using FTP. If 
you see the “Failed to open file” error message, 
type dir <ENTER> to view the correct file name.
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1.4 Setting up OS/2 NetBIOS Backup For Migration

Network protocols must be installed to back up an OS/2 voice messaging 
system using a NetBIOS over TCP/IP. 

A NetBIOS over TCP/IP configuration is required for a an OS/2 voice 
messaging system network backup.  Activation or upgrade codes are not 
required for network backups.

Make sure that the following installation information is available before starting 
the NetBIOS backup for migration: 

1.4.1 Configuring NetBIOS over TCP/IP

Configure TCP/IP and specify a Windows network domain name. If a 
domain does not exist, use the procedure described in Section 1.5 
Setting Up a Remote Windows Computer for a Backup on page 13-10 
in this chapter.

For a network backup using NetBIOS over TCP/IP, set up the system 
to log on to the network.  After installing network protocols, refer to 
Section 1.4.2 Setting Up an OS/2 Voice Messaging System to Log On 
to a Network on page 13-8 in this chapter.

Finally, set up a Windows computer to share a drive with the OS/2 
voice messaging system.  Refer to Section 1.5 Setting Up a Remote 
Windows Computer for a Backup on page 13-10 in this chapter.   

1.4.1.1 Installing Network Protocols for a NetBIOS Backup

1. Log on to the OS/2 voice messaging system.  The 
Banner page appears.

2. Press ESC on the Banner page and follow the 
system prompts.

3. Start an OS/2 command prompt. 

4. On the OS/2 command prompt, type f: <ENTER>.

Subnet mask
Router

Domain name
Server name

OS/2 voice messaging system
TCP/IP address

NOTE

Set up the Windows system as a workgroup environment with a 
unique TCP/IP address.
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5. Type cd\ <ENTER>.

6. Type setup <ENTER>.

7. Type y to proceed with the voice messaging system 
set up utility.

8. On the Choose Setup Type menu, type 2 to select 
Configure System, then <ENTER>.

9. Press OK to confirm that the voice messaging 
system is installed on drive E:.

10. Press OK to confirm that the voice messaging 
system is installed in the E:\VMAIL\ directory.

11. The Setup menu displays the features and options 
available on the system. Review the available 
options, then <ENTER>.

12. The Update Configuration menu appears. Click 
Configure Network Protocols (for Network Backup/
Restore) <ENTER>.

Make sure that all other options are cleared, then 
<ENTER>.

13. From the Select Network Protocols to Install/
Configure menu, type 2 (TCP/IP) and 3 (NetBIOS 
over TCP/IP), then <ENTER>. 

The TCP/IP Setup menu appears.

14. Type 1<ENTER>

15. Type the correct value for the TCP/IP Address field, 
then <ENTER>.

16. Type 2 <ENTER>.

17. Type the correct value for the Subnet Mask field, then 
<ENTER>.

18. Type 3 <ENTER>.

19. Type the correct value for the Default Router field, 
then <ENTER>.

20. Type 4 then <ENTER>.

21. Type the correct value for the Domain field, then 
<ENTER>
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22. Type 5 then <ENTER>.

23. Type the correct value for the Name Server field, then 
<ENTER>.

The NetBIOS over TCP/IP Setup menu appears.

24. Type 1 then <ENTER>.

25. In the Workstation Name field, type the Windows 
logon name of the voice messaging system, then 
<ENTER>.

26. Type 2 then <ENTER>.

27. In the NT Domain Name field, type the Windows 
domain name of the voice messaging system, then 
<ENTER>. 

28. Type 3 then <ENTER>.

29. In the Workstation Description field, type a 
description for the voice messaging system, then 
<ENTER>.

30. Review the entries to confirm that they are correct, 
then <ENTER> to continue. 

Setup configures the network protocols according to 
the information provided.

31. When the configuration is complete, the Setup 
Complete menu appears. Press <ENTER> to exit the 
setup utility.

32. Shut down the OS/2 voice messaging system blade 
by moving the Shutdown Switch to the UP position. 

33. After the system has fully shut down, move the 
Shutdown Switch back to the DOWN position then 
click the Reset button to restart the system.

NOTE

If there is no Windows domain, type the Windows 
workgroup name instead.
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1.4.2 Setting Up an OS/2 Voice Messaging System to Log On to a Network

To enable OS/2 voice messaging system to log on to a Windows 
network with NetBIOS over TCP/IP, perform the following procedure:

1.4.2.1 Logging On to a Windows Network

1. Add a Windows user ID and password with network 
access rights.

2. Specify the IP address of the network Primary 
Domain Controller (PDC).

3. Log on to the Windows domain or workgroup from an 
OS/2 voice messaging system.

4. Map a network drive.

5. Set up OS/2 voice messaging system to 
automatically log on to the Windows network 
(optional).

1.4.2.2 Adding a User with Network Access Rights

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Log on as an administrator by typing:

logon admin /p:admin <ENTER>

3. Add a user with network access rights by typing:

net user <userid> <password> /add <ENTER>

where <userid> and <password> are a valid user 
name and password on the Windows computer.

The userid and password must match the settings on 
the Windows computer.

4. Type logoff, then <ENTER>.

1.4.2.3 Specifying the Network Primary Domain Controller IP 
Address

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Type mpts, then <ENTER>. 

The Multi-Protocol Transport Services application 
starts.
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3. In the Multi-Protocol Transport Services dialog box, 
click Configure.

4. In the Configure dialog box, click LAN Adapters and 
Protocols, then click Configure.  The Adapter and 
Protocol Configuration dialog box appears.

5. In Current Configuration click IBM OS/2 NetBIOS over 
TCP/IP, then click Edit.

6. Click Broadcast list, then click Configure.

7. Make sure the IP address listed in the broadcast list 
is the correct IP address of the Primary Domain 
Controller (PDC) for the Windows domain. 

Consult with your network administrator to determine 
the correct PDC IP address.

8. Click OK to apply the change.

9. Click Close to close the Configure dialog box.

10. Click Exit to close the Multi-Protocol Transport 
Services application.

11. Double-click the Shutdown icon on the desktop to 
restart OS/2.

1.4.2.4 Logging On to the Windows Domain or Workgroup Using 
NetBIOS

1. On the voice messaging system, go to an OS/2 
command prompt.

2. The command options used depend on if you are 
logging on to a domain or a workgroup:
 

Domain

Type: 
logon <userid> /p:<password> 

/d:<domain> <ENTER>
Where 

user id = Windows user name
password = Windows password
domain = Windows domain name

Workgroup

Type: 
logon <userid> /p:<password> 

<ENTER>
Where 

userid = Windows user name
password = Windows password
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1.4.2.5 Mapping a Windows Network Drive

1. On the voice messaging system, go to an OS/2 
command prompt.

2. Specify a drive name for the NetBIOS share directory 
by typing:

net use x: \\<server>\<share> <ENTER>.

Where <server> is the name of the Windows 
computer and <share> is the name of the shared 
directory on the Windows computer.

1.4.3 Logging On to Windows Automatically 

An OS/2 voice messaging system can be configured to automatically 
log on to the Windows network using the following procedure: 

1.4.3.1 Automatically Logging On to Windows Using NetBIOS

1. Make a backup copy of the Startit.cmd file.  Go to the 
OS/2 command prompt and type:  
e c:\startit.cmd <ENTER>

2. Go to the beginning of the file and insert the following 
command lines. If you are not using a domain, insert 
everything except:  /d:domain. 

logon <userid> /p:<password> /d:<domain> 
<ENTER>

net use h: \\<server>\<share> <ENTER>

Use the correct values in place of <userid> and 
<password>. <Server> is the Windows computer 
name, and <share> is the Windows directory share 
name.

3. Save the file, then exit the text editor.

4. Shut down the OS/2 voice messaging system blade 
by moving the shutdown switch to the SHUTDOWN 
position. After the system has fully shut down, move 
the shutdown switch back to the RUN position then 
press the reset button to restart the system.

1.5 Setting Up a Remote Windows Computer for a Backup

When creating a back up of the OS/2 voice messaging system, set up a 
Windows computer without a Windows network domain.

To set up this configuration, follow the applicable set of procedures on the 
following pages. For more detailed instructions, ask your network administrator 
or refer to the Windows network documentation.
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1.5.1 Windows NT, 2000 or XP Setup

To configure Windows 2000, Windows NT, or Windows XP for remote 
backup, perform the following procedure:

1.5.1.1 Setting Up an NT, 2000 or XP Workgroup

1. Log on to the Windows NT or 2000 computer with 
administration access rights.

2. Right-click the My Computer icon, then select the 
Properties.

3. On the Network Identification tab, confirm that the 
computer name is all one word with no spaces.

4. Click Properties, then type a unique Workgroup name 
that is different from any domain on the network.

5. Write down the computer name and Workgroup 
name. This information is required to set up an OS/2 
voice messaging system.

6. Click OK.

1.5.1.2 Setting Up an NT or 2000 User ID and Password

1. Set up new accounts, use the operating system 
documentation to set up new accounts. 

Alternatively, if you want the NEAXMail IM-16 OS/2 
system to use the default Guest account, enable the 
single user Guest account and confirm that the Guest 
password is set.

2. Confirm that the single user Guest account for this 
step is being used. This is different from the Guests 
group account.

3. For either the Guest or new account, clear the check 
box for the User must change password on the next 
log on field.

4. Write down the account user ID and password. You 
need these values to set up NEAXMail IM-16 OS/2.

5. Click Apply, then click Close to complete the setup.
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1.5.1.3 Setting Up Share-Level Access for NT, 2000 or XP

1. On the Windows Desktop, double-click the My 
Computer icon.

2. Right-click the drive or directory to share with the OS/
2 voice messaging system, then choose Sharing.

3. Select the Share this folder field, then set the 
appropriate Share name.

4. If sharing drive C, do not use the default C$setting. 
Instead, select New Share and create a new sharing 
profile.

5. Click Permissions, click Everyone, then click Remove.

6. In the Permissions dialog box, click Add, then add the 
Guest or the new user account set up in the previous 
procedure. 

7. Set up the read/write privileges for the user account, 
then click Apply.

SECTION 2 MIGRATING FROM A DOS VOICE MESSAGING SYSTEM

2.1 About Migration

UM8000 supports migration from previous products. This chapter describes the 
steps required to migrate data from a DOS voice messaging system to Linux. 

You can migrate most existing data from a DOS voice messaging system into a 
new UM8000 system. This includes the system database (system configuration 
settings, subscriber accounts, groups, transaction boxes and interview boxes), 
and all messages, voice names and greetings. Customized prompts cannot be 
migrated.

2.1.1 Migration Setup Steps

Migrating from DOS to Linux requires the following steps. Complete 
instructions for each step are included in this chapter.

1. Back up and compress the a DOS voice messaging system 
data.

Refer to Section 2.2 Backing Up a DOS Voice Messaging System 
on page 13-13 in this chapter.

2. Transfer compressed back up data to a support computer.

3. Remove the a DOS voice messaging system blade.
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4. Install the UM8000 blade.

5. Transfer the back up data from the support computer to the 
UM8000 server.  

6. Run the migration procedure on the voice messaging server. 

Refer to Section 1.3 Migrating the Backup Data on page 13-4 in this 
chapter.

2.2 Backing Up a DOS Voice Messaging System

The DOS Voice Messaging System data must be backed up before the data 
can be migrated to the new voice messaging system.  After the data is backed 
up, it must be compressed before transferring the data to a support computer. 
The following types of data can be included in the DOS backup:

Messages

Voice names

Greetings

Subscribers

System settings

Transaction boxes

Interview boxes

Groups

The following procedures assume that CoSession and the Backup and Restore 
Utilities (BRU) are installed on the support computer running the Windows 
operating system, and a direct connection has been established. 

For more information about these applications or using a modem connection, 
see the DOS voice messaging system documentation.

2.2.1 Backing Up the DOS Database

1. At the Windows support computer, start the CoSession Remote 
client.

2. In the CoSession Remote Viewer Control Center, choose the 
voice messaging system in the Name list box.

3. Click Call. 

The voice messaging system Banner page appears.

4. Press ESC to shut down the voice messaging system. 

After the voice messaging system shuts down, the Utility menu 
appears.
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5. On the Utility menu, select Voice Mail Utilities. 

The Voice Mail Utility menu appears.

6. On the Voice Mail Utility menu, select Backup, Restore, Update - 
BRU utility. 

The voice messaging system restarts.

7. In the CoSession Remote Viewer Control Center, click Hang Up. 

The CoSession connection is terminated. Wait approximately two 
minutes for the BRU host to start.

8. On the support computer, run C:BRU\BRURMT.exe. 

The BRU client starts.

9. Confirm the connection settings are correct, click Connect to BRU 
Host via null modem cable, then choose OK.

If the BRU is able to connect, the status bar at the bottom of the 
window says CONNECTED. Repeat this step until a connection is 
established. 

10. On the Main menu, select Backup then press OK.

11. On the Backup menu, select Database, OGMs, and Messages 
then press OK.

12. Type the directory name where the backup will be stored on the 
Windows computer, then click OK. For example C:\Backup.

13. Type a description for the backup, then choose OK. For example  
DOS Voice Messaging System Backup.

14. Press OK to confirm the backup description.

To proceed with the backup, press OK.

Depending on the number of outgoing messages (OGMs) and 
messages on the system, the backup takes up to three hours to 
complete.

15. After the backup is complete, press any key to continue.

16. On the Main menu, select Exit the BRU Host and BRU Remote, 
then click OK.

17. Type y to disconnect and exit the BRU Remote session.
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2.2.2 Compressing the Backup Data

After the backup is complete, the backup files must be compressed to 
the proper format for migration to UM8000.

2.2.2.1 Compressing the DOS Voice Messaging System Backup 
Data

This procedure assumes that the WinZip compression 
application is installed. 

1. On the Windows taskbar, click Start > Programs > 
WinZip > WinZip.

2. Click File > New Archive….  The New Archive window 
appears. 

3. On the New Archive window, choose a location for 
the compressed file. 

4. Type a name for the compressed data file.  For 
example, type C:\temp\backup.zip.

5. Click OK.  The Add dialog box appears. 

6. In the Add dialog box: 
a Browse to the directory where the DOS backup 

files are located. For example C:\Backup.
b In the Folders section, check the Include 

subfolders check box.

c Click Add with wildcards.  WinZip starts 
compressing the backup files.  When WinZip 
finishes compressing the files, a list of the 
compressed files appears. 

7. Click File > Exit to exit WinZip.

Next step…
◆ Remove the DOS voice messaging blade from 

the phone system. 

CAUTION

If a different file compression program is installed, the 
backup data must be compressed from the top of the 
backup directory with the subdirectory structure intact.

CAUTION

This option must be selected or the migration 
fails.
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2.2.3 Transferring the Backup Data to UM8000

The following procedure assumes that a backup has been completed 
and the files compressed. 

2.2.3.1 Transferring the Backup Files

1. Log into the Web Administration Console.

2. Go to System/Backup and restore/Restore.

3. Use the browse icon to find the database to migrate 
on the support PC, this can include mapped network 
drives.

4. Choose upload.  After uploading the database, it 
appears in the local backup list.

2.3 Migrating the Backup Data to UM8000

Perform the following procedure to migrate the DOS data to the UM8000 
database.

1. In the pull down menu for the uploaded database, choose restore.

2. When prompted, confirm database restore.

3. When the migration completes, you will receive a message.

4. Go to Server Control.

5. Stop the voice messaging system.

6. After the application stops, choose to start the voice messaging system.

WARNING

The migration cannot be completed if there is a user logged on to the UM8000 
Web administration console. Users must log off the Web administration 
console before migrating.
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Updating UM8000

SECTION 1 OVERVIEW

Updating the voice messaging system includes installing new languages, 
installing additional ports, applying patches, or installing a new version of 
the software.  

All voice mail features are licensed through the CD-CP00-( ) of the 
SV8100.  A license maybe required to add additional voice messaging 
software language packs or additional voice ports. The license is based on 
the Hardware Key of the CD-CP00-( ) for the system. Contact your sales 
representative to obtain a new license code.

SECTION 2 CHANGING LICENSING INFORMATION

All licensing is stored on the CCPU.  This allows for failed CD-VM00 to be 
replaced without having to obtain new licenses for the enabled features.  
Licenses are enabled using Web Pro, PC-Pro or phone programming.  The 
UM8000 is enabled for the following UM8000 licenses at default:

0 Ports Voice Mail

5 Seats Unified Messaging

3 Languages

In addition, the following language prompt sets are loaded at default:

US English

French (Canadian)

Spanish (Latin America)
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SECTION 3 ADDING/REMOVING LANGUAGE PACKS

The following procedures enable you to install new language packs and remove 
existing language packs. 

3.1 Installing New Language Packs

To install the new language packs:

1. Start the Web administration console.  The the Web administration 
console appears. 

2. Under System, click Configuration.  The System configuration page 
appears.

3. Click Languages.  The installed language packs appear on the page.

The following table lists the two-letter codes used for the language files and
their associated soft keys.

4. Click Browse.  The Choose file dialog box appears. 

5. In the Choose file dialog box, browse to the location where the language 
packs are installed. 

NOTE

The UM8000 solid state disk only contains prompt sets for three languages. To use 
additional languages, purchase additional licensing.

Code Language
AR Argentinian Spanish
AU Australian English
CA Catalan Spanish
CT Cantonese
DE German
DK Danish
ED Madrid Spanish
ES Mexican Spanish
FC Canadian French
FR Parisian French
HE Hebrew
IT Italian
JA Japanese
LA Latin American Spanish
MD Mandarin Chinese
NL Dutch
NZ New Zealand English
PI Iberian Portuguese
PT Brazilian Portuguese
RU Russian
SE Swedish
UK UK English
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6. Choose the language file. 

7. Click Open.  The Choose file dialog box closes, the Install Language 
button appears on the Languages page. 

8. Click Install Language.  The Updating… button appears. It takes a few 
minutes for the language pack to install. 

The following message appears when the language has been installed:
Changes to the voice messaging system have been made. This requires the
voice messaging software to be restarted. Restart the voice mail software
after all system changes have been completed. 

9. Click Restart, to restart the voice messaging software.  The Server 
control page appears, both the Start and Stop buttons are greyed out 
while the server shuts down. 

10. Reprogram the phone system. 

3.2 Removing Language Packs

To remove the language packs:

1. Start the Web administration console.

The the Web administration console appears. 

2. Click Server Control.  The Server control page appears. 

3. Click Stop.  The voice messaging software shuts down. 

4. Under Quick Links, click System Configuration > Languages.  The 
installed language packs appear on the languages page.

5. To remove a language, click the Remove next to the language.

6. Under Quick Links, click Server Control.  The Server control page 
appears. 

7. On the Server Control page, click Start to restart the voice messaging 
system. 

NOTE

The voice messaging software must be stopped to remove language 
packs.
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SECTION 4 GLOBAL TONE DETECTION

Use the following procedure to run the global tone detection (GTD).  GTD checks the 
phone system or central office tones. 

To run Global tone detection:

1. Start PuTTY.  The login prompt appears.

2. Log in as admin <ENTER>. 

3. Type the password, voicemail <ENTER>.  The Main menu appears. 

4. Stop the voice messaging software, click 3 Control, then click OK.  The System 
control menu appears. 

5. Click 1 Stop the voice messaging software, then click OK.  The voice 
messaging system stopping appears. 

6. Click 1 Configuration, then click OK.  The Configuration menu appears. 

7. Click 4-Global tone detection, then click OK.  The Maintenance menu closes 
and a command line interface appears. 

8. Select one of the following options. Option 1 is the default.
 

9. Press <ENTER>. The GTD application starts. 

SECTION 5 APPLYING PATCHES, HOT FIXES, OR UPDATES

Updating the voice messaging system might include a full version update, a hot fix, a 
patch, or other similar change. Use the Maintenance menu to apply updates to the 
voice messaging system. 

Voice messaging software updates are available for download at the Active Voice 
Support FTP site. When an update is available for download the Active Voice Support 
team sends notifications out with the URL and log on information. 

To update the voice messaging software, use the following procedure:

1. Download the update file to the /opt/vmail/var/update directory. 

1  Detect PBXKSU (switch provided) 
tones
2  Detect central office (CO) tones. 
3  Exit this application 

CAUTION

The only file located in the /opt/vmail/var/update directory should be the current 
update. All other files must be deleted. 
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2. Start PuTTY.

3. Log on as admin. 

4. Type the password: voicemail.  The Main menu appears. 

5. Choose 2-Maintenance, then press <ENTER>.  The Maintenance menu 
appears. 

6. Choose 1-System update, then press <ENTER>.  An alert message appears:  
The voice messaging software must be stopped to perform this action.  Would 
you like to stop the voice messaging software now? 

7. Press TAB to choose YES, then press <ENTER>.  The voice messaging software 
starts to shut down.  When the voice messaging software has shut down, an alert 
message appears asking if you want to continue the update. 

8. Press TAB to choose YES, then press <ENTER>.  An alert message appears.  

9. Press TAB to choose YES, then press <ENTER>.  An alert message appears 
stating that the system was updated.  When an update is successfully applied, 
the update file can be deleted. 

10. Choose 0-Return to previous menu, then press <ENTER>. 

11. Choose 0-Log out, then press <ENTER>. 
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